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PREFACE

Welcome to the Oracle Insurance Insbridge Enterprise Rating Insbridge Upgrade Guide. The Insbridge
Enterprise Rating (Insbridge) System is a browser-based, multiplatform insurance rating and underwriting
technology solution that provides integrated management for every aspect of the rate definition and
modification process. The purpose of this guide is to assist with the upgrading of the Insbridge Enterprise
Rating System.

There are different types of upgrades available to the 5.6.1 release of the Insbridge system:
o RateManager/IBFA
o SoftRater for Windows
e SoftRater for Apache TomEE

This document focuses on upgrading RateManager/IBFA and SoftRater for Windows. Also included are
the steps for upgrading SoftRater for Apache TomEE.

Note: You may have done many of these steps as part of your 5.6.0 installation, you can skip
them if not needed.

AUDIENCE

This guide is intended for system administrators, installers, database administrators and others tasked with
installing and configuring the Insbridge system and associated databases.

TYPES OF INSTALLATION

There are various types of installations:

RateManager Installation
o RateManager for Windows — Installs RateManager and the Insbridge Framework Administrator
(IBFA) in a Windows environment and utilizes IBFA for local rating. This Windows only
environment uses a SQL Server database.
SoftRater Installation
o SoftRater for Java Installation — Deploys Insbridge SoftRater Server (IBSS) to Apache TomEE.
o SoftRater for Windows Node — This installation is for existing environments that want to add a
SoftRater for Windows node to an environment. This is for a Windows only environment using a
SQL Server database.
Upgrading a Current Installation
o Upgrade — Upgrades existing customers from their current version of Insbridge up to version
5.6.1.
This guide describes upgrading an existing environment.

Definitions
Some commonly used terms when installing or using the Oracle Insurance Insbridge Enterprise Rating
system:

e IBER: Insbridge Enterprise Rating System. Most often referred to as Insbridge. This is the entire
system.

o IBFA: Insbridge Framework Administrator. IBFA is an administrative tool used to configure
Insbridge applications and setup RateManager database connections. IBFA will be located on a
Windows Server machine. IBFA/SR-WIN is an Insbridge Framework Administrator/SoftRater for
Windows.

e IBSS: Insbridge SoftRater Server. IBSS is the administrative tool for the SoftRater engine. The
SoftRater engine is a multi-platform component within Insbridge that executes the rules, rating and
underwriting instructions as defined by the user in RateManager. IBSS is usually located on a
Java machine. IBSS/SR-JAVA is an Insbridge SoftRater Server/SoftRater for Java.

o SoftRater Node: A SoftRater node is either an IBFA (without RateManager) or IBSS instance on
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a physical environment.

RM: RateManager. RateManager is a component within Insbridge that enables users to manage
the product definition and modification process, including rating and underwriting logic.

SR: SoftRater. The engine that executes the rating, rules and underwriting instructions defined
within RateManager. The rating environment for runtime execution and processing of business
content. SoftRater can be further defined by the operating system where it has been loaded.
SR-WIN: SoftRater for Windows. This is also another name for IBFA.

SR-JAVA: SoftRater for Java. This is also another name for IBSS.

SRP: SoftRater Packages. A package that holds all the RateManager logic for a specific program
and version.

VES: Virtual File Servers. Virtual file server management allows you to access environments that

are located on other machines in different locations where packages can be downloaded.

same as a SoftRater node.
e Logical Environment: An environment created for a subscriber in IBFA. It defines package
location, engine location and database location in addition to several other supporting data items.
This environment is used for rating and/or SRP management. Each database connection will
have a logical environment.

Related Documents
For more information, refer to the following Oracle resources:

Package Location: A pointer to a location where SoftRater Packages (SRP’s) are stored.
Physical Environment: A physical environment is generally referred to as a physical machine.
Authoring Environment: The physical machine where RateManager is installed.

Rating Environment: The physical machine(s) where SoftRater is installed. This is typically the

e The Oracle Insurance Insbridge Enterprise Rating Operating Environments for Hardware and
Software.

e You can view this guide on-line at this address:
https://docs.oracle.com/en/industries/insurance/index.html

Manual History
New editions incorporate any updates issued since the previous edition.

Publication

Product

Edition : Publication Date Comment
Number Version

1st Edition P01-788-01 May 2011 Initial Release
2" Edition  P01-788-02 R45.1 September 2011  Update
3rd Edition P01-788-03 R 4.6 May 2012 Update
4th Edition P01-788-04 R4.6.1 November 2012 Update

5th Edition P01-788-05 R4.7.0 September 2013  Update

6t Edition P01-788-06 R4.7.1 November 2013 Update

7t Edition P01-788-07 R 4.8 August 2014 Update
8th Edition P01-788-08 R 4.9 December 2014 Update

9t Edition P01-788-09 R5.0 June 2015 Update
10t Edition  P01-788-10 R5.0.1 August 2015 Update
11" Edition  P01-788-11 R5.1 December 2015 Update
12t Edition  P01-788-12 R5.2 July 2016 Update
13t Edition  P01-788-13 R5.3 October 2016 Update
14t Edition  P01-788-14 R5.4 January 2017 Update
15t Edition  P01-788-15 R5.5 September 2017  Update
16" Edition  P01-788-16 R5.6 August 2018 Update
17" Edition  N/A R5.6.1 July 2020 Update
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SYSTEM UPGRADE REQUIREMENTS

Prior to upgrading an Insbridge system, please have the following ready:

The Insbridge User Account information.

The location of the current Insbridge installation.

The Insbridge User has administrative rights or proper permissions to run an installation and start
the Insbridge Message Service and the Insbridge Task Manager Service.

You must run as Administrator for any upgrade.

Administrator User name and password for RateManager.

OR

Access to the Insbridge databases. Updates are run against the IBRM, the IB_CLIENT database
and the IBSR SoftRater database.

Subscriber, database, and environment information.

Important: You must be on Insbridge release 5.6.0 before you attempt an upgrade to
5.6.1

Insbridge 5.6.1 content
Prior to installation, please make sure the source machine(s) where Insbridge will be loaded has an unzip
utility. An unzip utility for most platforms is available on the Oracle Software Delivery Cloud download

page.

Documentation is in PDF format. Prior to installation, ensure the source machine(s) where Insbridge
documentation will be loaded has a PDF reader.

The installation downloads contains:

Insbridge-Windows — Required for all RateManager installations. The Insbridge installation is for
a 64-bit system.

Insbridge-TomEE-eng — Required if you are using Apache TomEE

Documentation: Itis recommended that you download the documentation. Installation guides
are located here.

The Insbridge-Windows folder contents:

Databases
o Oracle
SoftRater — IBSR
o Batch
= IBSS5611A20.1.zip

Oracle Insurance - Insbridge Enterprise Rating.exe
The Insbridge-TomEE-eng folder contents:

IBSS.ear
Docker

o Docker.dat

SoftRater can be installed any time after the Insbridge Framework Administrator and RateManager have
been installed. SoftRater must be installed prior to any users creating packages. All the folders and files
may not be needed, depending upon the installation.

Internet Explorer
IBSS and IBFA are accessed via web browser. Verify that you are using Internet Explorer 11.
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ADMINISTRATIVE USER ACCOUNTS

No administrative account is created when Insbridge is installed. An administrative user account must be
created on the server where the Insbridge system is going to be installed. This required account is the
Insbridge Local User Account.

The Insbridge Local User needs to be a member of the User group and requires certain privileges in order
to fully control the entire Insbridge environment. For ease of installation and if the server is dedicated to
the Insbridge Enterprise Rating System, this user can be added to the local machine Administrators group.

File Permissions

The Insbridge User requires read/write permissions on:

e The Windows Temp Folder. This is necessary for MSMQ.

e The Insbridge Application Pool Identity

e The Insbridge Folder
The Insbridge user must also be given full control over the following registry key:

e HKEY_LOCAL_MACHINE/SOFTWARE/Insbridge
It is recommended that the databases be on separate machines from the applications due to performance
and security issues. The Insbridge applications and databases can be tenants in an already existing
setup. IBFA uses port 80 by default. Please check with your system administrator for port conflicts with the
existing setup. The ports used by SoftRater for Java can be changed from the default to a fixed port if
needed.

Extended Permission Required by the Insbridge User
In order to start the Insbridge services from IBFA, the Insbridge user must be given full access to both the
Insbridge Message Service and the Insbridge Task Manager Service. If the Insbridge user account will not
have full administrative permissions on the server where the Insbridge Framework is installed, then
certain operations from IBFA will not be available. A system administrator may be required to start the
Insbridge services from the server.

Insbridge User Password
The password can be set to any password that meets your company standards. The Insbridge
administrator must make note of the password for future configuration.
For ease of maintenance, the Insbridge user should not have to change the password and the password
should never expire.

The installation automatically applies the Insbridge user name and password to the necessary libraries,
virtual directories and, if used, Internet Proxy settings in IBFA. If you change the Insbridge user password,
you will have to change the password in all three of the Insbridge Com+ libraries, all three of the Insbridge
virtual directories and, if you are using it, the Internet Proxy settings in IBFA.

NOTE: Please note that if your company requires passwords to be re-set, you will have to make changes
to the COM+ Application libraries, virtual directories and if you are using it, the Internet Proxy
settings in IBFA after you change your password. You also may re-install the application. This
recreates the COM+ applications, virtual directories and IBFA instance with the updated Insbridge
user password. Be aware that re-installing the application may also reset security settings in IBFA.

Installer Permissions
The installation program requires that the installer have administrator rights on the machine where the
install is occurring. The install must be run as administrator.

NOTE: If the Installer has permissions, an Insbridge User account can be created from within the install.
If you create an Insbridge user from the install, you may not be able to set the permissions you
need. Please be sure to verify the proper permissions are in place before continuing.
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Application Server Permissions
The SoftRater Server (IBSS) application servers Apache TomEE require read/write permissions on the
Insbridge.net.softraterconfig.xml that resides in the shared directory for all nodes. Also required is full
control on the SoftRater node instance directory creates the config files and log files for that JVM.

DATABASE USER ROLES AND PERMISSIONS

If a more granular approach is required for management of security of the Insbridge databases, then the
following guidelines can be used to set permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the Insbridge
Enterprise Rating System will fail. An experienced database administrator’s expertise is highly
recommended before making any security changes.

Recommended RateManager Permissions:
It is recommended that the IBRM and IB_CLIENT database user have:
e Adatabase owner (db_owner) role. db_owner access is needed to execute the Insbridge
stored procedures and have full access to the Insbridge schema.
o Disk Admin permissions are also recommended in order to create backups within
RateManager.

For the IBRM and IB_CLIENT databases, if db_owner permissions are not possible, the database will
need to be updated manually. If disk admin permissions are not allowed, backups will have to be done
outside of RateManager.

IB_CLIENT and IBRM Database File Location
UPDGRADING IB_CLIENT and IBRM — The preferred method of updating the IBRM and IB_CLIENT
databases is to run them through RateManager. If the RM administrator has DB User privileges and is the
DB Owner of the database as well as the disk administrator, database updates can be done on the
Tools>Database—>Updates tab. If these privileges are not in place, an error message is displayed.

IB_CLIENT and IBRM databases can be updated manually by downloading the scripts from
RateManager Tools->Database->Updates tab and running them directly in SQL Server. Scripts must be
run in sequential order. You must have SQL SERVER permissions to run update scripts. You must have
RateManager admin permissions to access the Tools—>Database—>Updates tab.

If needed, new IB_CLIENT, and IBRM files are located in the download file available from Oracle
Software Delivery Cloud. You might have received this as part of the 5.6.0 distribution.

Recommended SoftRater Permissions:

The recommended permissions are required for new tables to be created in the SoftRater (IBSR)
database dynamically when an SRP (SoftRater Package) is loaded to the SoftRater system. If the
recommended permissions are not possible, manual steps will need to be performed that will allow for
packages to be loaded.

SoftRater utilize Oracle database.
e Insbridge SoftRater Oracle Database.

Itis recommended that the Insbridge user be granted, as defaults, the “CONNECT” and
“RESOURCE’” Roles.

SoftRater Database File Location
In the event that db_owner permissions are not possible, scripts will have to be run to create the
necessary tables. Tables are required for each Project and or Product. If the tables are not created, the
packages cannot be loaded.

NEW IBSR — New Oracle and DB2 DDLS are located in the SoftRater file on the Insbridge installation
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server ONLY.

DDL scripts can be found on the server where Insbridge was installed in the

...\\Oracle\lnsbridge\SoftRaterfolder.

For example: C:\Program Files\Oracle\Insbridge\SoftRater\DDL

il ooL (= 1= S|
“ Home Share Wiew (7]
© [CiiPragram Files\Oraclelnsbridge SoftRaterDDL] v| & | | searchDDL 2 |
)
Oracle 2 MName Type Size
Insbridge o
COM+ DB2 File folder
Oracle File folder
Framework
DK SqlServer File folder
SoftRater
DDL
DB2
Oracle
SqlServer
Webs
Insurance v.
3 items =

For SQL Server, new backup files are included in the Insbridge download in the Windows folder under

databases. If the IBSR backup files cannot be used and DDL scripts are needed, SQL Server DDL scripts
can be found on the server where Insbridge was installed in the .

UPGRADING IBSR — An Upgrade folder is located inside each of the database types with one upgrade
script and Instructions for running the update. When upgrading from a release prior to release 5.0. users

must create new and re-load packages.

Only one update script is available per database type. This script covers all updates from the last schema
change. This reduces the number of potential upgrade scripts users must run and assures that the scripts
are run in the correct order. Any script that has already been run will be skipped. This change allows for

easier management of IBSR update scripts.
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Creating Tables
When creating tables for a SoftRater database: The template name must be edited to create the proper
tables. A table must be created for each product in each project.

1. The SoftRater data table template name should follow the pattern:
DT+PROJECT+ _ +PRODUCT+ _ +SUBSCRIBER
For example: FOR PROJECT #1 AND SUBSCRIBER #206 AND PRODUCT #1 use:
DT1 1 206 and PK_DT1 1 206 forthe template holder

CREATE TABLE [DT1_1_206]
Or

CREATE TABLE [dbo].[DT1_1 206] (

2. Runtables in order found in the file: For example, in the Oracle file you would start with
oracle.create.dt.template.sql,then oracle.create.packages.sql, and so on.

3. Runthe update script last.

Oracle
SoftRater database schema is support by all available ORACLE database platforms.

JDBC Driver Class

“oracle.jdbc.driver.OracleDriver”
Using prefix jdbc:oracle:thin:

Supported Versions — 11¢g, 12c, 19c
User Account Requirements

Create Table
Create Index
Query access to “SYS.OBJ$”

NOTE: Performance may be impacted if using the default optimizer_features_enable setting on Oracle
12c. For optimal performance, Insbridge recommends setting the optimizer_features_enable
parameter to 11.2.0.4.

The command to set optimizer feature enabled on Oracle 12c is:
alter system set optimizer_features_enable ='11.2.0.4";

Ref Url: https://docs.oracle.com/database/121/REFRN/GUID-E193EC9E-B642-4C01-99EC-
24E04AEA1A2C.hm#REFRN10141
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Chapter 1 — System Upgrade Requirements

IBM DB2
SoftRater database schema is supported on version 9.7.

JDBC Driver Class

“‘com.ibm.db2.jcc.DB2Driver”
For Native AS400 — “com.ibm.as400.access.AS400JDBCDriver”

Supported Version — 9.7

User Account Requirements

Connect to database

Create Table

Create Packages

Query access to “SYSIBM.SYSTABLES”

Configuration Settings
Required
The query dynamics of the SoftRater system requires some modification to Configuration

settings. The following Performance Configurations parameters required to the target SoftRater
database.

Instance Level — ASLHEAPSZ >= 1024
Instance Level - QUERY_HEAP_SZ => 10240
Database Level - APPLHEAPSZ >= 1024

Recommended
The query dynamics of the SoftRater system will benefit from the following modification to
Configuration settings.
Instance Level — INTRA_PARRALLEL (Yes) — For Symmetrical Processing Machines (CPU >=2)
Database Level — DFT_DEGREE (-1) — For Symmetrical Processing Machines (CPU >=2). Allow
the optimizer to determine the degree of intra-partition parallelism based on the number of
processors and the type of query.
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UPGRADING RATEMANAGER, IBFA AND SR-WIN

NOTICE: The machine where Insbridge is located needs to be rebooted prior to upgrading.
Rebooting is necessary to assure that com+ settings are properly updated, Insbridge services
are properly stopped and all users are logged off.

Windows should be up and running prior to upgrading.
This update takes RateManager and the corresponding IBFA to release 5.6.1.

Steps to Upgrade RateManager/IBFA
The steps to follow for upgrading RateManager/IBFA depend upon what Insbridge release you are
starting from:

Upgrading from Release 4.8.X or previous to release 5.6.1 requires:

A new system requirement and a new file structure have been introduced and affect any 4.8.X or previous
release. Insbridge files are now placed in a different location on the server from previous releases. This
change requires subscriber, database, and environment information to be re-entered either manually or by
copying and placing previous config.xml files to a new location.

A new application pool also is created. This may require updates to any service or web site that calls the
Insbridge application. If the Insbridge portal is being used, updates need to be made there as well.
e OPTIONAL: For reference, make a copy of the Insbridge config.xml file. Set aside.
e Step 1: Verify or Install .NET 4.5.2.
e Step 2: Reboot system.
e Step 3: Runthe Insbridge exe to update the application.
e Step 4: Enter IBFA and Configure:
Subscriber
Database connections
Environment
e Step 5: Installing the OBI Publisher.
e Step 6: Start Insbridge Message Service.
e Step 7: Run the required IB_Client, IBRM and Reporting database updates.
e Step 8: Update Preferences.
e Step 9: Update Group Rights

e Step 10: Send notice to RM users to completely clear cache, including Preserve Favorites website
data.

NOTE: Updates to the databases can be performed manually, if desired. Manual updates are performed
directly in SQL Server.

Additional Step to Upgrade RateManager/IBFA:
You also will need to run these steps if you want to make previous workfiles available to users
This procedure takes RateManager and the corresponding IBFA to release 5.6.1 and assures that
previous workfiles are available to users.

e Step 1: Migrate Workfiles.

e Step 2: Update Portal URL and security.
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Upgrading from Release 4.9.X to release 5.6.1 requires:

Step 1: Verify or Install .NET 4.5.2.

Step 2: Reboot system.

Step 3: Run the Insbridge exe to update the application.

Step 4: Start Insbridge Message Service.

Step 5: Login to RateManager and perform IB_Client, IBRM and Reporting database updates.
Step 6: Update Preferences.

Step 7: Update Group Rights

Step 8: Send notice to RM users to completely clear cache, including Preserve Favorites website data.
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Steps to Upgrade SoftRater for Windows from a Previous Release
The steps to follow for upgrading SoftRater for Windows depend upon what Insbridge release you
are starting from:

Upgrading from Release 4.8.X or previous to release 5.6.1 requires

A new system requirement and a new file structure have been introduced and affect any 4.8.X or
previous release. Insbridge files are now placed in a different location on the server from previous
releases. This change requires subscriber, database, and environment information to be re-entered
either manually or by copying and placing previous config.xml files to a new location.

A new application pool will also be created. This may require updates to any service or web site that
calls the Insbridge application. If the Insbridge portal is being used, updates will need to be made there
as well.

This setup must utilize SQL Server.
o OPTIONAL: For reference, make a copy of the Inshridge config.xml file. Set aside.
e Step 1: Verify or Install NET 4.5.2.
e Step 2: Reboot system.
e Step 3: Runthe Insbridge exe to update the application.
e Step 4: Enter IBFA and Configure:
Subscriber
Database connections
Environment
e Step 5: Installing the OBI Publisher.
e Step 6: Start Insbridge Message Service.
e Step 7: Restore new SoftRater database.
e Step 8: Update Preferences.
e Step 9: Update group rights.
e Step 10: Re-load packages.

e Step 11: Send notice to RM users to completely clear cache, including Preserve Favorites website
data.

Upgrading from Release 4.9.X to release 5.6.1 requires
e Step 1: Verify or Install .NET 4.5.2.

e Step 2: Reboot system.

e Step 3: Runthe Insbridge exe to update the application.
e Step 4: Start Insbridge Message Service.

o Step 5: Restore new SoftRater database.

e Step 6: Update Preferences.
e Step 7: Update group rights.

e Step 8: Re-load packages.

e Step 9: Send notice to RM users to completely clear cache, including Preserve Favorites website data.
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UPDATING AN INSBRIDGE APPLICATION

Upgrading from Release 4.8.X or previous to release 5.6.1 requires:

A new system requirement and a new file structure have been introduced and affect any 4.8.X or
previous release. Insbridge files are now placed in a different location on the server from previous
releases. This change requires subscriber, database, and environment information to be re-entered
either manually or by copying and placing previous config.xml files to a new location.

A new application pool will also be created. This may require updates to any service or web site that calls
the Insbridge application. If the Insbridge portal is being used, updates will need to be made there as
well.

This procedure takes RateManager and the corresponding IBFA to release 5.6.1.
e Step 1: Verify or Install .NET 4.5.2.
e Step 2: Reboot system.
e Step 3: Runthe Insbridge exe to update the application.
e Step 4: Enter IBFA and Configure:
Subscriber
Database connections
Environment
e Step 5: Installing the OBI Publisher.
e Step 6: Start Insbridge Message Service.
e Step 7: Run the required IB_Client, IBRM and Reporting database updates.
e Step 8: Update Preferences.
e Step 9: Update group rights.

e Step 10: Send notice to RM users to completely clear cache, including Preserve Favorites website
data.

NOTE: Updates to the database can be performed manually, if desired. Manual updates are performed directly
in SQL Server.

Upgrading from Release 4.9.X to release 5.6.1 requires:
e Step 1: Verify or Install .NET 4.5.2.
e Step 2: Reboot system.

e Step 3: Runthe Insbridge exe to update the application.

e Step 4: Start Insbridge Message Service.

e Step 5: Login to RateManager and perform IB_Client, IBRM and Reporting database updates.
e Step 6: Update Preferences.

e Step 7: Update group rights.

e Step 8: Send notice to RM users to completely clear cache, including Preserve Favorites website data.
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STEP 1—-VERIFY OR INSTALL .NET 4.5.2

STOP: .NET 4.5.2 is REQUIRED. DO NOT RUN the Insbridge executable prior to verifying
.NET4.5.2 is installed.

.NET 4.5.2 is not included with the Insbridge installation. The .NET 4.5.2 download can be
obtained from Microsoft.

NOTE: If you are updating from release 4.9, you can skip this step.

.NET 4.5.2 requires .NET 3.5.1 features to be installed prior to installing .NET 4.5.2. Failure to use .NET
4.5.2 results in errors when accessing IBFA.
1. Toverify .Net 4.5.2, select Run from the Start Menu.
2. Type regedt32. Click OK. The Registry Editor will open.
3. BrowsetoHKEY_LOCAL_MACHINE->SOFTWARE->Microsoft>NET Framework
Setup>NDP->v4->Full.

£ Registry Editor

File Edit View Favorites Help

[ | Inkernet Explorer d Iame | Type | Data |
- L) MM ab){Default) REG_SZ {value not set)
B [ Mobile 5| Install REG_DWORD 000000001 {1}
- L MosTrace ab)InstallPath REG_ST C\windows\Micrasoft MET\Fr amewarksdw4,0, 30519
M- | MSBEuild ani EEG DWORD 000000004 (1
By M3DE REG_DWORD 0x0005chFS (379893) |
B MSDTC e ErVICg TEG Dons T e
- MEF ab| Target¥ersion REG_SZ 4.0.0
-, MSlicensing ab]yersion REG_S7 4.5.51209
[ MSMO ! =
[ | MS5QLServer
- | MapServer
[=1- |, MET Framewark Setup
B | NDP
[ | CDF
B v2.0.50727
w30
w35
RN
""" . Metsh
[ L) Metwork
- | MetworkAccessProtectic
----- . Man-Driver Signing
[#- | Motepad
[+~ | ODBC
- | Cffice
- 1 Ole
[ | Qutlook Express
- L PLA
(- | Powershel
[#- | Print
[+~ . RADAR
[+~ | Ras
[#- | Reliability analysis
- | RemovalTools -
1] o ;lJ
|C0mputer'l,HKE\"_LOCAL_MACHINE'l,SOFTWARE'l,Microsoft'l,NET Framewark. SetupiNDPw4Full 4

Figure 1 Verifying .NET 4.5.2 in Registry

4. The release number should read 379893. If the number is smaller or the Full folder is not
present, .NET 4.5.2 has not been installed. Make sure to look at the v4 folder. DO NOT look
at v4.0.

5. If .NET 4.5.2is installed, close out the registry and continue.

6. If NET 4.5.2is not installed, you must install before you can continue. .NET 4.5.2 must be
installed prior to running the Insbridge installation. .NET 4.5.2 requires .NET 3.5.1 features to be
installed prior to installing .NET 4.5.2. Make sure .NET 3.5.1 is installed prior to installing .NET
4.5.2.

NOTE: .NET 4.5.2 is not included with the Insbridge installation. The .NET 4.5.2 download can be
obtained from Microsoft.
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Troubleshooting

If you receive an error when accessing IBFA:
Could not load type 'System.ServiceModel.Activation.HttpModule' from
assembly 'System.ServiceModel, Version=3.0.0.0, Culture=neutral,
PublicKeyToken=b77a5c561934e089

This error may happen when there are multiple versions of .NET Framework on a machine that is running
IIS and did not get registered properly.

Please see http://msdn.microsoft.com/en-us/library/hh169179(v=nav.71).aspx for more information.
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STEP 2—- REBOOT SYSTEM

The machine where Insbridge is located needs to be rebooted prior to upgrading. Rebooting is
necessary to assure that com+ settings are properly updated, Insbridge services are properly
stopped and all users are logged off.

Windows should be up and running prior to upgrading.

If the Insbridge Message Service is set to automatic, you must stop the service prior to running the install.
Failure to stop the Insbridge Message Service may result in the upgrade not completing properly.

811972015 12:01 AM  Application 1,847 KB

ﬁllnshridge 5.0.1 Setup M =] B3 |

Inztalling —
Please wait while Insbridge 5.0.1 is being installed. (;J

e I T N Y ]

Cukp
‘a Insbridge 5.0.1 Setup H

. ! Error opening file For wriking:

CHPROGRAM
FILESYORACLEVIMSERIDGE Frameworki4, 5,04 Insbridge. Met . Engin
e.RLdl

Zlick. &bort bo stop the installation,

Retry to by again, or
Ignore ko skip this File,

Abork | Retry | Ignore |

rullsaft Install Systenm w2 46

= Back | Zlase | Zancel |

Figure 2 Failure to Reboot Server Error Message
Failure to reboot may cause the update to fail.

Failure to Shut Down Com + Services:

Failure to shut down Com + Services may result in a configured identity error message when users access
RateManager. Users may receive an error message that an incorrect username and password are being
used or remote access is not allowed.

To correct reboot the server where the Insbridge System was installed. When Windows is up and running,
run the Insbridge executable to remove the Insbridge system. Rerun the Insbridge executable again to re-
install.

To verify Com+ was updated, enter Com+ and verify the Identity of each of the Insbridge Com+ Services

is the Insbridge user. The Identity can be found on Properties->ldentity.

NOTE: The Insbridge Com plus services are started when users access the system.

Failure to Shut Down Insbridge Message Service:
Failure to shut down the Insbridge Message Service may result in an error message being displayed
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during installation and failure to completely install the required Insbridge executable. The best way to
ensure the Insbridge Message Service has completely shutdown is to reboot the system.

iii!:ll‘ Oracle Insurance Insbridge Setup Ed |

Files In Use DR ACLE

Saome filez that need ta be updated are currently in use. INSURANCE

The faollowing applications are uzing files that need to be updated by thiz zetup.

Insbridge MessageQueue Service

* Automatically close all applications and attempt to restart them after setup is complete.
" Do not cloze applications. [& reboot will be required. |

Wize Inztallation Wizard [R]

Cancel |

Figure 3 Insbridge Message Service Running During Update
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STEP 3— RUNNING THE INSBRIDGE APPLICATION

An update to the Insbridge system is run from the Oracle Insurance — Insbridge Enterprise Rating.exe.

Unzip the Insbridge-Windows folder on the machine where the Insbridge system (IBFA and RateManager)
is currently installed.

NOTE: The installation program requires that the installer have administrator rights on the machine
where the install is occurring.

NOTE: Please close all open applications before running the Oracle Insurance - Insbridge Enterprise
Rating file.

1. Begin with the Oracle Insurance - Insbridge Enterprise Rating Install file. You must run as
administrator.

2. Open the Oracle Insurance — Insbridge Enterprise Rating file. A Welcome screen is displayed.

13! Oracle Insurance - Insbridge Enterprise Rating Setup M

4 Oracle Insurance Insbridge

[t iz gtrangly recammended that vou exit all Windows programs befare running this setup program.

Click Cancel ta quit the setup pragram, then close any programs vau have running. Click Mest ta
continue the installation.

WARMIMG: This program iz protected by copyright law and international treaties.

IInauthaorized reproduction or distribution of this program, or any portion of it, may result in severe
civil and cnminal penalties, and will be prozecuted to the maximum extent pozsible under law.

ORACLE

INSURAMNCE

| | Canicel

Figure 4 Installing Insbridge
3. Click on Next to continue.
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13! Cracle Insurance - Insbridge Enterprise Rating Setup  [= [ & -
Destination Folder ORACLE

Select a folder where th lic:ation will be installed.
elect a folder where the application will be installe INSURANCE

The Wize Installation *fizard will install the files for Oracle Insurance - Insbridge
Enterprize Rating in the following folder.

Toingtall into a different folder, click the Browse button, and select another folder.

“'ou can chooze not to install Oracle Insurance - Ingbridge Enterprize Rating by clicking
Cancel to exit the Wize [nztallation Wizard,

Drestination Folder
CAPROGRAM FILESSORACLEMMNSERIDGES

Wize Inztallation YWwizard [R]

| | Cancel

Figure 5 Destination Location for Update

4. The destination path is displayed next. This is an information only screen. Click Next.

i3 Oracle Insurance - Insbridge Enterprise Rating Setup | — | = -
Logon Information GRACLE‘

The following | infarrnation | d by Insbridge.
& following logon information is used by Insbridge INSURANCE

Specify a uzer account to be used by the application, either for running a service or for
logaing onto other servers. Use the Browse buthon to choose uzers from vour netwaork,
For domainz, user names must be in the format of DOMAINSU ze ame.

Password: | eeeeseee |

| Create Mew Lser...

YWize [nstallation Wizard®

< Back " Mewt > | | Cancel

Figure 6 Entering User Information for Insbridge

5. The next screen is the Logon Information screen. Please use the Insbridge user account information

that you set up for the initial installation. Click Next to continue.
Upgrade Guide
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12l Oracle Insurance - Insbridge Enterprise Rating Setup M

Select Features C}RACLE‘

Pleaze zelect which features you waould like to install.
d INSURANCE

Insbridge Enterprize B ating

Feature Description:

Oracle Insurance Insbridae Enterprize A ating is
R aweb-bazed rating, rulez, and undensriting
zyzhem.

Thiz feature will be installed on the local hard
drive.

I hiz heature requires UKE an your hard dnve. It
has 2 of 2 subfeatures zelected. The
subfeatures require 34888 on wour hard drive.

Wize [ngtallation wizard [F]
| Dizk Cost | | Bezet | | < Back " Mext > | | Cancel

Figure 7 Selecting Features to Install

6. The next screen lists the applications to be installed. To expand the options and view details, click on
the downward arrow. All features are checked for installation. RateManager is the only one that you
will be allowed to not install. Click Next.

Options are:

e Insbridge Enterprise Rating:
The default option is: Entire feature will be installed on local hard drive.
You will not be able to opt out of this selection.
¢ RateManager:
The default option is: Entire feature will be installed on local hard drive.
You will be able to opt out of this option. Select Entire Feature will be unavailable.
RateManager will not be installed.

NOTE: Do not install the RateManager option for SoftRater for Windows (SoftRater Node) updates.
e IBFA:
The default option is: Entire feature will be installed on local hard drive.
You will not be able to opt out of this selection.
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12l Oracle Insurance - Insbridge Enterprise Rating Setup M
Ready to Install the Application ORACLE

Click Mext ta begin installation,
ick. Mest to begin installation INSURANCE

Click the Back button ko reenter the ingtallation infarmation or click Cancel to exit
the wizard.

Wize [ngtallation wizard [F]

Figure 8 Ready to Install

7. A Ready to Install screen is displayed. If you are ready, click Next. Otherwise click Back to check the
options you want to install. A progress screen displays your progress.

NOTE: If you receive a message that the system will need to be rebooted after the installation, STOP
THE INSTALLATION. This message means that the Insbridge Com + services are running. If
you get this message:

1. Stop the Installation.
2. Reboot the server.
3. Start the Installation over.

4. If the Insbridge Message Service is set to automatic, you must stop the service prior to running
the install.

8. When complete, a ReadMe Information screen is displayed.
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12l Oracle Insurance - Insbridge Enterprise Rating Setup M

4 Oracle Insurance Insbridge

Oracle Insurance - Insbridge
Enterprise Rating has been
successfully installed.

Click. the Finish buttan tao exit this installation.

ORACLE
INSURANCE

Cancel

Figure 9 Completed Installation

9. Click Finish to finish the installation. The installation should complete successfully.
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STEP 4 — CONFIGURING INSBRIDGE FRAMEWORK ADMINISTRATOR

A new system requirement and a new file structure have been introduced and will affect any 4.8.X or
previous release. Insbridge files are now placed in a different location on the server from previous
releases. This change requires subscriber, database, and environment information to be re-entered either
manually or by copying and placing previous config.xml files to a new location.

NOTE: If you are updating from release 4.9 or later, you can skip this step.

UsING PREVIOUS CONFIG.XML FILES

If you do not want to re-enter IBFA information, you can copy and paste the previous config.xml file from
the old location to the new location.

Step 1: Copy the Previous Insbridge. XML File
You can copy and paste the Insbridge XML file from the old machine to the new machine. This will allow
the environments and subscriber created in the old machine to be populated in the new machine.

NOTE: If you want to re-enter or re-create your environments, you can skip Step 4 and Step 5. After you
import the registry key, you will need to continue the RateManager/IBFA installation at Step 7 —
Configuring Insbridge Framework Administrator.

File Location:
The location of the Insbridge. XML file to be copied will depend upon what version of RateManager the old
machine is running. There are two possible locations.

For Release 3.12 and earlier:
e File Name: InsBridge. XML
e Location:  D:\ProgramFiles\InsBridge\Framework\2.0.2\InsBridge.Xml.
OR C:\Program  Files\Oracle\insbridge\Framework\2.0.0\Insbridge.Xml
For Release 3.13t0 4.8.x:

e File Name: InsBridge. XML
e Location: C:\Program Files\Oracle\IGBU\Insbridge\Framework\3.5.0\Insbridge.Xml

Copy the Insbridge. XML file to a location you can easily access.

NOTE: If you are changing databases, you can copy and paste the Insbridge XML file, however you will
need to update your environments with the new database information.
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(-?(:)v| . = 10101010100 = Local Disk (C:) = Program Files = Oracle = IGEU - Insbridge - Framework - 3.5.0 = - l_ﬂ]_]l Search 3.5.0 @]
Organize * @ Open v  Mew Folder == S| ﬂ
. Oracle ;I Mame Date maodified Type | Size l;l
Lip
1B N N
e Previous Location
| come Applicabion
. Framework [&]instal_oracle_client_for_insbridge.bat 8i12/2014 2:48 AM ‘Windows Batch Fils 1KEB
. 3.5.0 [ installutil, exe 6{10/2009 1:39 PM Application 24 KB
Batch || InstallUtil. InstallLag 12/29{2014 ::23 &M INSTALLLOG File 2KB
fop %] Interop, COMAdmin.dil S/1Zf2011 7:08 AM Application extension 36 KE
2‘;‘;% %] Interop, DEOFle di 6j22/2011 5142 AM Application extension 11 KB
adar_inshridge DMessagaService.axe 4j712011 331 PM Application 45 KE
| oracle_dataaccess_set | MessageService. exe.config GIZZ{2010 4:31 PM COMFIG File 2KB
. Reports | MessageService, InstalLog LZ/Z902014 925 AM TNSTALLLOG File ZKEB
. Temp =] Messageservice. xml 8/1Z{2014 Q45 AM SML Document IKB
. 50K || Messageservice, xsd GI17/2009 %31 AM  X5D File 3B
i SoftRater %] Microsoft, Web. Services3. dil 8122009 12:18 PM Application extension 864 KB
In;b\::;zf %] Microsoft, Web, ULWebContrals dll g/12/2009 12:18 PM Application extensian 168 KB
| ComM+ (&) Myp,smldl L1J2712005 11:06 PM Application extension 173 KE
. Framewark — %] Oracle.Datafccess di 10§13/2008 5:54 AM  Application extension Q00 KB
. 450 (w1 RegTves.exe 61002009 1:40 FM Application 25 KB
. Batch || softservices. config 7I21{2014 2:44 PM COMFIG File 2KE
+ fFop 5] TaskManager.exe 8/18/2009 1:36 PM  Application 328
: EETPG 7] TaskManager . exe.config FITIZ003 342 PM COMFIG File 1KB
| adac_inshridge || TaskManager.InstalLog 12f29)2014 223 AM  INSTALLLOG File 2KB
| oracle_dataaccess_setu =] TaskManager . xml 12/5/2003 12:54 PM XML Document 1KE
|| TaskManager,«sd 5j712003 12:24 PM %30 File 2KB Z

. Reparts LI

<gh> InsBridge.¥ml Date modified: 7/21/2014 1:03 PM
Size: 9.51 KB

RML Document

Date created: 12/2/2013 3:14 PM

Figure 10 Previous Config.xml file Location

Step 2: Paste the Insbridge. XML File
Before pasting the Insbridge. XML file into the new location, make a copy of the blank Insbridge. XML file
and store in a safe location. In the unlikely event that an error occurs, you will have a backup file that you

can use.

The Inshridge. XML file in the New Machine is located:

C:\Program

Files\Oracle\insbridge\Framework\4.5.0\insbridge.Xml

1. Make a copy of the blank Insbridge.XML file on the new machine and store in a safe location.
2. Paste the Insbridge.XML file from the old machine in to the new machine in the same location.
3. Open an Internet Explorer web browser either remotely on the local Insbridge web server and

browse to IBFA location on the new machine: http://SERVERNAME/ibfa/

4. Subscribers and Environments should be available in IBFA on the new machine. Verify your

entries.
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http://servername/ibfa/

Search 4.5.0

Organize * {éOpen *  New folder

. Oracle ;I Marme Date madified Type Size l;l
| tin o e i
| 1GBU %| Insbridge.Met Engine.Build . RM.dIl 12{23/2014 12:13PM  Application extension 216 KB
. Insbridge Insbridge.Met. Engine.PackageLoader .l 12{18/2014 7134 AM Application extension 159 KE
. COM+ %) Insbridge Met,Engine RI.dll 1212212014 12:35PM  Application extension 432 KB
| Framework | Instridge et Engine.RI Hb 12/29/2014 9:23 AM  TLE File 17KB
350 | Insbridge. Met, Fusk.dl 12{20{2014 Z:00 AM Application extension 454 KB
S::h 7] Insbridge. Net, Fusk.dll.config 12/17]2014 1;59 FM COMFIG File 1 KB
PG || Instridge Mek. Fusk.tb 12{29/2014 3:23 M TLE File 43KB
OBI Insbridge.Met. Licensing. dil 10/20/2014 355 FM Application extension ZEKE
. odac_insbridge %] Insbridge . Met. ProgramReportsEngine . dil 12/13/2014 12:52 AM  Application extension 120 KB
. oracle_dataarcess_set %, Insbridge Met.RM.Packaging.dll 12/18/2014 6:02 &AM Application extension 139KE
/ Reports | Insbridge. Met. Spoke. Inkerface.dil 10f22j2014 7:06 AM Application extension 16 KB
1 SD;KTBFHD Insbridge. Met, Spoke. Inkerface.Hh 11/21/2014 311 PM__ TLE File ] .
| softhater B 1nstridge.sm 12/8/2014 4:00PM  KML Document: NeW Locatlo n
. Webs =] InsBridge_Copy Xl 12/8/2014 9:39 AM ®ML Docurnent KB
. Insbridge w77 InsbridgeLibsComPlusReqister, exe 12/20/2014 237 PM Application ITKE
. COM+ install_oracle_client_for_insbridge. bat 12/29]2014 923 AM twindows Batch File LKB
b Framepcrk T [ mstalltiexe 9112013 6:39PM Application 40 KB
: 4‘?? . | Installuil. Installog 12{29{2014 9:23 &M INSTALLLOG File 11 KB
fop (271 Messageservice.exe 12/13/2014 3::54 AM  Application S2KEB b=
GruPG 7| Messageservice.exe. config 10f17/2014 6113 AWM CONFIG File ZKB
OB1 || MessageService InstallLog 12{29/2014 2:23 AM  INSTALLLOG File 7 KB
odac_insbridge || MessageService. Installtate 121292014 2:23 AM INSTALLSTATE File KB
oracle_dataaccess_setuf ] MessageService sanl 12/20/2014 223 AM  ¥ML Document 3KE
Reparts LI MessansServire. wsd A TERNNG A:51 AM ST File: AKR ﬂ
<@> InsBridge. ¥ml Date modified: 12/3/2014 4:00 PM Date created: 11/21/2014 3:11 PM
#ML Document Size: 7.86 KB
Figure 11 New Config.xml File Location
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Logging in to IBFA
If you have elected to re-use an existing config.xml file, IBFA should be populated with the same
information as the previous Insbridge instance.

If you want to re-enter the information, IBFA will be blank.
Open an Internet Explorer web browser and browse to the following location, replacing SERVERNAME

with the actual server name:
http://SERVERNAME/IBFA

The default security setting for a new installation is Custom and requires a login to access.

L3 )| & hetp://win1100000/IBFA/ P~ & || & Framework Administrator (... *

ORACL_E msurance Insbridge Framework Administrator Version 05.05.00 (x64)

Show FrameworkAdmin Menu

Explorer not configured. Please contact your system administrator.

Click “Show Framework Admin Menu” to display login options.

Figure 12 IBFA Landing Page

1. IBFArequires a login to access. Click the Show FrameworkAdmin Menu link to display the login.
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http://servername/ibfa/

= | O -
a@‘ @ hitp://win1100000/1BFA/ P-c H (2 Framework Administrator (... | | 1 & X

ORACLE nsuance Insbridge Framework Administrator Version 05.05.00 (x64)

x Explorer not configured. Please contact your system administrator.
& Access Secure Services
User ID:

Log On

Copyright © 2000,2009, Oracle and/or its affiliates. All rights reserved.

Figure 13 IBFA Login Screen

2. Enter the default User ID and password:

User ID: admin
Password: insbridge
3. The IBFA home page is displayed.

Troubleshooting
For MS Windows 2012 R2 installations, you may receive an error when accessing IBFA for the first time:

The data protection operation was unsuccessful. This may have been caused by not having the
user profile for the current thread’s user context, which may be the case when the thread is
impersonating.

If this error is presented, locate the Insbridge Application Pool on the server where Insbridge was

installed. Administrative Tools > 1IS Manager->ORACLE_FSGBU_INSBRIDGE, right click, and
select Advanced Settings. Change the Load User profile to True.
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Updating IBFA Security
1. Itisrecommended that you change the login password immediately. You do not have to change
the password.
2. Onthe left side menu, select Security > Change Password.

Change 'Custom Security’ Admin Password
Insbridge suggests that you use a password that is 6-8 characters long. If you think someone else knows the admin

=3 Insbridge

+-C3 SoftRater password, please contact your system administrator,
[l SoftData

- Services

H-[ Legs Old Password

El'_J Searity New Password

i-:; Softlibraries Confirm Password

- ) Help

Update

Figure 14 Updating the Default Password

3. Enter in the default password for the old password and enter in the new password of your choice.
Confirm the new password and click Update. A success message is displayed when the admin
password is updated. If an error message is displayed, make corrections and try again.

4. If you do not want to require a login, you can change the security to None. This changes the
default landing page to the IBFA home page and removes any login requirements.

Framework Administration Web Security
B3 Insbridge To utilize Windows authentication please select the Windows security option and contact your system administrator to

F-C1 SoftRater update your II5 settings, The Insbridge Custom Forms authentication requires that you enter an admin user and password
combination for web access.
-~ SoftData

-~ Services
-1 Logs
=8 | security | () MNone
1 Change Password ) windows
E’; Softlibraries

- @) Help

[] Allow unauthorized users to view secure environments? (read-only)

External API Access

The Insbridge Framework Administrator has an open API for back-office system automation. To allow an external process
to connect to this node, enable and set the access key below,

() Digabled

(® Enabled |ceB8de543-00d5-4bd3-87ca-f451b6237575 Generate Key

Figure 15 Selecting Security for IBFA

On the left side menu, select Security.
Select None for Framework Administration Web Security for no security. The landing page will be
updated the IBFA home page and no login will be required.

o u

NOTE: You also can select to use Windows security. Please see the IBFA user guide for more
information on setting up Windows security.
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Entering Company Information
If you have elected to re-use a previous config.xml file, you may skip to the next step.

Prior to users entering RateManager, the Insbridge Framework Administrator must be configured for your
company.

- | O -
a@\é hitp:win1 100000/ 57 2 - 0| @ Fromework Adminitator (.. % || ok
ORACI_E. Insurance Insbridge Framewark Administrator Version 05.05.00 (x64)

3]

=] a j Configuration File [C:\PROGRAM FIL ES\ORACL E\INSBRIDGE\FRAMEWORK4.5.0\Insbridge.Xml]
§-03 SoftRate The Framewark Administrator Web will configure any Insbridge Framework Configuration file (Insbridge.xml) found on
OftRater your network. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all
[ 3 softData apps that reside on the same Framework Server share the same file.
[ 3 services
Change Config File location: C:\PROGRAM FILES\ORACLE\INSERIDGE\FRAMEWORK\4.5.0\I | Edit || Apphy
-4 Logs
=4 Security Click on "Edit” button to enable the text box above. Copy and paste the new Insbridge XML file location in the text box.

Then dick on "Apply” butten te apply the new configuration file.

[ Change Password

£ Softlibraries Add Subscriber
- @) Help € subscniber igentifier is an unigue number that vou would like to represent your company. Please consult with an

Insbridge support representative if you have any questions.

(Click on the id of the subscriber in the list to edit.

# No Subscribers found.

Add Database Connection
Create or edit database connection. This database connection can be global to the Insbridge Framework or unique to the
Subscriber.

Click on the name of the connection to edit.
€4 Global

# No Connections found.

Copyright © 2000,2009, Orade and/or its affiliates. All rights reserved.

Figure 16 IBFA Home

NOTE: If you receive an access denied error message, please verify that you have given the Insbridge
user full control of the Insbridge folder.

NOTE: If you receive an IDNX denied error message, please verify that the Insbridge user has full control
over the Inshridge directory. Regedt->Insbridge Directory-> Security.

There are five steps that need to be done in IBFA:

e Step 1: Creating a New Subscriber
Step 2: Adding a Global Database Connection
Step 3: Adding a Security Database Connection
Step 4: Adding an RM security Database Connection
Step 5: Creating a RateManager Environment

Step 1: Creating a Subscriber:

A subscriber is a group or collective of users and environments under a single identity. This identity is
used to manage and configure the group’s activities and databases. A subscriber may be a single
company, a group within a company, or a single person.

The ID, Name and Description are selected by you. The ID and Name are fixed after the first time you
save. These entries cannot be edited. Only the description can be edited.
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Click on Add Subscriber on the Main IBFA screen. A separate screen is displayed.

Enter the ID, Name and Description for your subscriber.

When you finish entering the information, click Save. The new subscriber will now be displayed in
the list of subscribers.

wn e

2l Subscriber -- Webpage Dialog -

Subscriber
Please enterf/update yvour Insbridge Customer information below.

1D B659
Mame: Alamere

Desc:  Alamere Insumncd ®

Save Cancel

Figure 17 Enter ID

NOTE: Make note of the subscriber ID number. You may need to enter this on another IBFA or IBSS
environment.

The Subscriber ID can be a 1-5 digit number and must unique for each subscriber. For example,

if you have an instance of IBFA on machine A, you can create a subscriber with an ID of 100. On
machine A, if you create another subscriber, you must give that subscriber a different ID number,
say 200. If you also have an instance of IBFA on a different machine, B for example, you should

duplicate the same subscribers with the same ID humbers on machine B.

If you require assistance or are unsure of what action to take, please log a Service Request using
My Oracle Support at https://support.oracle.com/.
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Next Step: Add Database Connections:

BE

G@‘ @ http://win1100000VIBFA/ default.aspx/servername P~ H ;g Framework Administrator (... | | ﬂ% {\? {§}
. .
ORACLE msurance Insbridge Framework Administrator Version 05.05.00 (x64)
x
3 .
-0 SoftRater = Configuration File [C:\PROGRAM FILES\ORACLE\INSBRIDGE\FRAMEWORK\4.5.0\Insbridge.Xmi]
03 softData The Framework Administrater Web wil configure any Insbridge Framework Configuration file (Insbridge.xml) found on your
netwaork. Although all Insbridge Applications may have their own version of this configuration file, we suggest that all apps
[ services that reside on the same Framework Server share the same file.
1 Legs =
ion: Eq Al
B-E3 Security Change Config File location pply
ﬁ';") Softlibraries Click on "Edit” button to enable the text box above. Copy and paste the new Insbridge XML file location in the text box.
Then dick on "Apply™ butten to apply the new configuration file.
@) Help
Add Subscriber

The subscriber identifier is an unigue number that you would like to represent your company. Please consult with an
Insbridge support representative if vou have any questions.

IClick on the id of the subscriber in the list to edit.

# 8659 - alamere - Alamere Insurance

| Add Database Connection |

Create or edit database connection. This database connection can be global to the Insbridge Framework or unigue to the
Subscriber.

[Click on the name of the connection to edit.
£ Global

# No Connections found.

Copyright © 2000,2009, Orade and/or its affliates. All rights reserved.

Figure 18 Adding Database Connections

Stay on the Main IBFA screen. Three databases must be added to IBFA:

e Subscriber: Global with Name: controller. This is a global database and is required for logging in
to the Insbridge system. This is not unique to the subscriber.

e Subscriber: (Your Subscriber Name) with Name: security. This is a subscriber specific
database and is required for subscriber security information.

e Subscriber: (Your Subscriber Name) with Name: RM. This is a subscriber specific database and
is required for RateManager. This information will also be used when creating the RateManager
environment.

The setups are similar for all three databases. The description information following the first example will
be the same for the other two databases.

NOTE: If you have renamed the databases, please make note of the new names.

To continue, you will need to exact names of the databases you restored in Step 5, IBRM_xxxx, and
IB_CLIENT databases.
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Step 2: Adding a Global Database Connection:
Begin by filling out connection information for the IB_CLIENT database using the Global subscriber.

1.

From the Insbridge page, click the Add Database Connection link. This opens the Connection
screen.

3

Connection -- Webpage Dialog -

Con

nection
Database connections can be global to the Insbridge Framewark or unigue to the Subscriber.

Subscriber: | Global v
Mame: Controller
Server: 10.100.10.100 Test Connection...

Server Type: | SQLServer ﬂ

Catalog: IB_CLIENT

Catalog Type: IDther ﬂ

Query Buffer:

Tablespace:

Schema:

User: ]

Password: (TTITTITY] -

Save Cancel

Figure 19 Setting up the Global Database Connection

2. Select Global for the Subscriber.

3. Enter Controller for the Database Name. The name must be Controller. This cannot be changed
once you have saved it.

4. The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

5. The DB Server Type is the type of server that houses the database. The controller, security and
rm databases are all SQL Server.

6. Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.

7. Selectthe Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type
RateManager.

8. Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

9. The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

10. Click SAVE to save your work. You will be returned to the main Insbridge page. The controller

database will be listed.
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Step 3: Adding a Security Database Connection:

1.
2.

No

10.

Next, add the security database. Select the Add Database Connection link again.
Select Your Subscriber. The security database is unique to the subscriber.

A Connection -- Webpage Dialog -

Connection
Database connections can be glabal to the Insbridge Framewark ar unique to the Subscriber.

Subscriber: IMamere Insurance v
Name: Security
Server: 10.100..10.100 Test Connection...

Server Type: |SQLServer | w|

Catalog: IB_CLIENT

Catalog Type: | Other v

Query Buffer:

Tablespace:

Schema:

User: 53

Password: (TTITTITITY -

Save Cancel

Figure 20 Setting up the Security Database Connection

Enter Security for the Database Name. The name must be Security. This cannot be changed
once you have saved it.

The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

Enter IB_CLIENT for the Catalog. This is the IB_CLIENT database you restored in step 5.
Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type
RateManager.

Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed
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Step 4: Adding an rm Database Connection:

1.

2.
3.
4

o

No

10.

Next, add the rm database. Select the Add Database Connection link again.

Select Your Subscriber. The rm database is unique to the subscriber.

Enter rm for the Database Name. This cannot be changed once you have saved it.

The Server is the database server name or IP address whichever is resolvable by the Insbridge
web server. You also can test the connection and make sure it is valid at the time of entry.

The DB Server Type is the type of server that houses the database. The controller, security and
rm databases will all be SQL Server.

Enter IBRM_xxxx for the Catalog. This is the RM database you restored in step 5.

Select the Catalog Type. The types available are: RateManager, SoftRater and Other. The
controller and security databases will both be type OTHER. The rm database will be type
RateManager.

Query Buffer, Tablespace and Schema are not required for the controller, security and rm
databases.

The User and Password is for the SQL Server user (for example, insbridge) assigned as
database owner.

Click SAVE to save your work. You will be returned to the main Insbridge page. The controller
database will be listed
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21 Connection -- Webpage Dialog -

Connection
Database connections can be global to the Insbridge Framewark or unigue to the Subscriber.

Subscriber: |Mamere Insurance v
Name: RM
Server: 10.100.10.100 Test Connection...

Server Type: | SQLServer ﬂ
Catalog: IBRM

Catalog Type: IRateI‘-‘Ianager ﬂ

Query Buffer:

Tablespace:

Schema:

User: 5d

Password: TIITIIL -

Save Cancel

Figure 21 Setting up the RateManager Database Connection

NOTE: The Catalog Type must be set to RateManager when you are creating the Connection from
RateManager. If you leave it set to Other, you will receive an error.

Creating Logical Environments:
Next, create the default rating environment for the RateManager system.
For a new installation it is recommended that you create one logical environment:

¢ RM: to handle rating and testing.

You can create additional environments at this time if necessary or you can add them in at a later time.
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Step 5: Creating a RateManager Environment:
It is recommended that only one RateManager environment be created.

1. Browseto SoftRater>Explorer->Subscriber name.

BN @ http://win1100000/1BF A/ defauit aspx P+ & || @ Framework Administrator {.. % Tni n.f ol
ORACLE mnsurance Insbridge Framework Administrator Version 05.05.00 (x64)
S|
E-[3 Inshridge
B3 softRater
[ Engine
= B e Add Environment
- " or remove environments from your Explorer configuration.
[ SoftData
£3 services AME - DESCRIPTION
&0 Logs
B0 Security # No environments found.
52 softlibraries
@) Help Product Management
Your rating book of businesses are identified by an id and a description. There is no imit to the number of Product’s {line-of-
business) that your Explorer can contain.
D - DESCRIPTION
# No Products found.
Virtual File Server Manangement
There are times when you must download SoftRater packages from different locations. These locations require a domain
name of an ip-address of the particular server.
# No file servers found.
< >

Figure 22 Create a Rating Environment

2. Click on Add Environment.
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o

SoftRater
A SoftRater configuration can suppaort an unlimited number of environments.

MName: RM

Type: IDEU

Secure: ||

Figure 23 Entering Name and Environment

3. Enter a Name and select a Type. The name and type are totally dependent on how your
Insbridge system is designed.

There are three types of Logical Environments:
e Development

e Quality Assurance

e Production
After you have entered your logical environment, you must define it.

Defining the Logical Environment

ORACL_E msurance Insbridge Framework Administrator

Add Environment

Add, edit, or remove environments from your Explorer configuration.

Configuratiol

LS

NAME - DESCRIPTION

# BEM - Development
# QA - Quality Assurance
# Prod - Production

Figure 24 Obtaining Environment Information
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1. Selectthe Environments link under the Configuration header on the left hand side to enter the
configuration information for the newly created logical environment. You will be placed on the
Environments screen. The environments you previously setup will be listed. If an environment is
missing, you must return to the Configuration subtab and add it.

= | O -
e@‘ ,;’ http://win1100000VIEFA/ default.aspx JeR ] H = Framework Administrator (... | ‘ ﬂ% ix.? {§}
ORACI_G. Insurance Insbridge Framework Administrator Version 05.05.00 (x64)
553 Insbridge Content Settings

E-Ld SoftRater
- Engine

E-23 Explorer Configuration ~

Environments Environment{s) you may use for development purposes. Selecting an environment below will denote it as the default.

-1 SoftData

-~ Services Environment: RM ®

-1 Logs Test Envirenment...

[ Security DB Server: 10.100.10.100

ET:) Softlibraries DB ServerType: SQLServer ﬂ

@ Help DB Catalog: IBRM_AL

DB CatalogType: RateManager ﬂ
DB Query Buffer:
DB Tablespace:
DB Schema:
DB User: sa
DB Password: ~ eessssse
Engine Type: Windows v
Engine Location: LOCALHOST [ Location is a Cluster
Engine EnvDef: Discover
Environment{s} you may use for quality assurance purposes. Selecting an environment below will denote it as the default.
Environment: QA
Package Location: C:\Insbridge\Packages\Qa Test Environment. ..
DB Server: 10.100.10.100
DB ServerType: SQLServer ﬂ (¥
DR Catalon: TRSR_AT
< > Copyright © 2000,2009, Orade and/or its affiiates. All rights reserved.

Figure 25 Editing Environment

The Environment Name will be complete. No changes are needed.

RateManager environments will not have a Package Location. No entry will be allowed.

Enter in the DBServer name or IP address. This is the database server where the RateManager
database was restored. For DB2 servers, this is the DB2 Registered Alias Name. For Oracle
servers, this is the server name; either IP or DNS will work. The default port used is 1521. The
Database listener port number can be appended to the server name if it is something other than
the default port. The format for this is: [SERVER NAME]:.[PORT NUMBER]

NOTE:

If a specific instance of SQL Server is required, for example if a shared MS SQL Server is being
utilized, the format for this is: [SERVER NAME\INSTANCE NAME].[PORT NUMBER]

©No O

12.

The DB Server Type will be SQL Server.

The DB Catalog is the name of the RateManager database restored in SQL Server.

The DB Catalog Type is RateManager.

DB Query Buffer, DB Tablespace and DB Schema are not required for a RateManager
environment.

Enter the DB User name and Password.

. The Engine Type is Windows.
11.

The Engine Location default is LOCALHOST. Most RateManager installations have a local
engine location. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located. Do not change LOCALHOST to the name or IP
address of the local machine.

The Engine EnvDef default is a blank field. Most RateManager installations do not require an
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13.

entry in this field. If the IBFA engine location is not on the local machine, enter the server name or
IP address where the IBFA engine is located.

Click Save to save your entries. After you have saved your settings, a new tab will be displayed,
Content. This tab will not be needed for a new installation.

No further entries are required at this time. If you want to make additional entries you can.
Additional environments can be added at any time.

If you are running a Windows only environment you can set up your SoftRater databases at this
time. Follow the same procedure of restoring the database, then entering in IBFA.

Optional Setting: Threads
If you know the number of Web Rate Threads you need, you can enter this information now. If you do not
know, you can enter this information later. For more information on threads, please see the IBFA User

Guide.

WARNING: Before changing the number of threads, you should consult with your system

administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Insbridge recommends a maximum of 2 threads.

There are three thread settings in the Insbridge system:

Batch Packing Thread: Found on the Preferences screen of RateManager. This setting is the
maximum number of threads to be used for RateManager Batch Packaging. Batch packaging is
building of packages inside RateManager. This thread setting will not affect rating or any other
process in IBFA.

IBFA Web Threads: Found on the SoftRater Engine page in IBFA. This setting is the maximum
number of threads to be used for rating that is sent through the SoftRater web services. If you
want responses to be returned in the order submitted, this thread setting must be higher than the
maximum number of rate requests contained within a single XML request.

IBFA Message Services Threads: Found on the Message Services page in IBFA. Individual
thread usage can be set for Batch Rating, Batch Scenario and SoftRater-Package.
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o Packaging (Table Variable) Threads: Found on the SoftRater Engine page in IBFA. This setting
is the maximum number of threads to be used when packaging table data. If you want responses
to be returned in the order submitted, this thread setting must be higher than the maximum
number of rate requests contained within a single XML request.

STEP 5= INSTALLING THE OBI PUBLISHER

OBI Publisher is necessary for reports. If you do not plan on using reports in RateManager or IBFA, you
do not need to install this program. If you are updating from release 4.9, you do not need to re-install OBI
Publisher.

STOP: If you are updating from release 4.8 or earlier, OBl Publisher must be re-installed. Previous
instances of OBI will not work with any release after 5.0.1.

NOTE: If you are updating from release 4.9 or later, you can skip this step.

1. Unzip the OBI_PUBLISHER

# 0B Publisher Setup 9=
0B1 Publizher -
Release Maotes, (&J

Install l [ Cancel

Figure 26 Installing OBI Publisher

2. Click Install. A progress screen will be displayed.

3. When complete, click Close.
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4. In order for OBI Publisher to be available to users, you must start the Insbridge Message
Service. The Insbridge Message Service can be started from IBFA or from Server Manager on
the server where installed.

NOTE: The location and port for OBI Publisher is http://localhost:9704/xmlpserver/. This information may
be needed if you have to make a request to your company’s infrastructure and request the
security team to open the ports used by Publisher.

OBI Security

The OBI Publisher requires a default User ID and password to be entered in IBFA. OBl is required to
create certain reports in RateManager. Users will receive error messages if the OBI Publisher Credentials

are not completed.

-3 Inshridge Configuration File [C:\PROGRAIM
: FILES\ORACLE\IGBU\ INSBRIDGE \Webs\IBFA\ Systems\ SoftRater Xml\ rmxc.acml]
El'—J SoftRater Pleaze enter the SoftRater Explorer configuration information below.
1 Engine
6
[ SoftData Admin Email Address:
-l Services
B+ Logs
- Security
("1; SoftLibraries Internet Proxy: (®) None
@) Help O UserID Password

Intranet Credentials: (®) Use Anonymous
() Domain UserlD Password
0BI Publisher Credentials: UserlD Password

Save

Figure 27 OBI Publisher Credentials

1. Onthe left side menu, select SoftRater-> Explorer.
2. Locate the OBI Publisher Credentials.
3. Enter the default user name and password.

User ID: Administrator
Password: Administrator

4. Click Save to save your entry. You must click Save prior to exiting the page.
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Updating OBI Publisher Password

You can immediately update the OBI Publisher password if you want. The password must be updated in
OBI Publisher and then in IBFA.

1. Enter the OBI Publisher console. http://localhost:9704/xmlpserver where localhost is the machine
where IBFA/RM is installed.

2. Select the Admin tab.
3. Under Security Center, select Users.

4. Selectthe administrator Username.

TORACLE Bl Publisher Enterprise

Welcome, administrator Preferences Sign Out Help

Reports | Schedules | Admin

| Admin > Users > Update User: administrator]

Update User: administrator

Cancel I Apply

Username administrator

Figure 28 Updating the OBI Publisher Password

5. Enter in a new password and click Apply. This updates the Administrators password.
6. Sign out of OBI Publisher.
7. Enter IBFA.

8. Open the SoftRater Explorer Configuration window. Enter the same password in the OBI
Publisher Credentials.

9. Click Save. The password has been updated.
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STEP 6 — STARTING INSBRIDGE SERVICES

The Insbridge Message Service can be started on the server where Insbridge is installed or from the
Services screen in IBFA.

To start on the server go to Services and select to start Insbridge Message Service.

To Start in IBFA:

Insbridge Message Service Stop

The Insbridge Message Service is a Message Queue Listener that will route all batched messages to an assembly (process)
for execution. These processes may take resources and time to execute. Please consult with you system admin before

configuring the number of listeners per process.

| Batch Rating " | View Messages Edit Process Configuration

If vou see this message, yvou have not requested a listing from the selected spoke client. Clicking
wiew Messages will provide you with a list view of the first in - first out messages that are waiting to

execute.

Insbridge Task Manager Stop
The Insbridge Task Manager gives you the ability to execute daily, weekly, hourly, or by the minute.

View Tasks (This process may take a while to execute)

TASK LAST RUN-DATE START-TIME STATUS

Figure 29 Insbridge Services Screen

1. InIBFA, navigate to the Services page.

2. Nextto Insbridge Message Service, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

3. Nextto Insbridge Task Manager, click Start. After a few seconds, the buttons will refresh to
indicate that the service is started.

It is recommended that you also start the Insbridge Task Manager. The Insbridge Task Manager is a task
gueue that lists the tasks that are scheduled to be performed as well as the last time the task was run and

the status.

NOTE: Alogin screen is displayed on IBFA for new installs. An upgrade does not reset the current
security setting. For example, if a login was not required for IBFA, upgrading to release 05.01.00

will not change that.
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STEP 7 — UPDATING DATABASES

Database updates can be performed in RateManager for the IBRM, IB_Client and Reporting databases.
This is the recommended way to update these databases. If this is not possible, the databases can be
updated manually on the machine where they are located.

The SoftRater database needs to be updated manually on the machine where it is located.

To update the IB_Client, IBRM and Reporting databases, log into RateManager.

NOTE: You must be a DB Owner to run the update scripts in RateManager.

Updating Databases in RateManager

The URL for RateManager will be http://INSTALLATIONSERVERNAME/RM. Where Installation server is
the server where RateManager was installed. This places you on the RateManager login screen.

If you log into RateManager and Tools is the only option, you must perform a database update.

- | O -
e@|@ http://win1100000/RM/Main/MainPage.aspx?page=default PR ] H @ Oracle Insurance Insbridge ... | | {n i\? {§}
ORACLE" Insurance Insbridge RateManager
Fle | Tools | Help
Hor 3 oDatabase » |F}  Backups ==
E Updates
[7| DB Update =

a Please run the update scripts on the database.

Figure 30 Tool Mandatory Update
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1. Enter your username and password.

2. Navigate to the Tools>Database->Updates.

On the DB Updates screen, the current version is highlighted and the status is Current. The
updates below the current version are grayed out. These updates cannot be run again. You will
receive an error message if you attempt to run a lower version update. Any version update above
the current version will also be grayed out but will be available for executing.

Updates have to be installed sequentially, meaning if you are on Version 03.13, you must run the

04.00 update, the 04.01 update, the next, and finally the 05.01.00 update. If you attempt to run an
update that is more than one level above the current version, you will receive an error message.

3. The Updates tab is displayed. Select the database you want to view from the Show updates for
drop down. The database updates for your selection are listed. The last column, the Status
column, shows you which update is the Current one installed.

ORACLE" Insurance Insbridge RateManager

File Modules Tools Help

Home () DB Updates b
(@) DB Updates

.LT;'. Execute Update Script J__EOpen |Update Script E Save Update Script to File Eﬁ Refresh
Ehmupﬁmhr:m
Scnpt Release Date Database Status
w05.05.00.00 6/1/2017 IERM
v05.04.00.00 12/31/2016 IBR.M
05.03.00.00 10/31/2016 IBR

05.02.00.00 6/1/2016 IER

05.01.00.00 12/15/2015 IBR

05.00.00.00 41,2015 IBR

O4.09.00.00 11/1/2014 IBR

O<4.08.00.00 4/1/2014 IBR

04.07.00.00 3/1/2013 IER

Figure 31 Available Updates

4. There are two ways to execute an update:
a. Directly in RateManager

b. In SQL Server
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Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting the update
showing Current. This assures that the database showing as Current has all possible updates.

Database scripts must be run in this order: IB_CLIENT, IBRM and Reporting, Reporting must be last.

1.

2.

Highlight the update you want to run.

Click EXECUTE UPDATE SCRIPT. A warning message is displayed.

Click OK to run the update or Cancel to return to the previous screen.

Run all script in consecutive order until the 5.6.1 script is showing as current.

Run scripts in this order: IB_CLIENT, IBRM and Reporting. Reporting must be the last script
run. Do this for all database update scripts.

2| Confirm Update -- Webpage Dialog -

™ Are you sure you want to replace the
current database’s contents with the
_--”JI selected release script on disk?

2 Ok i Ccancel

Figure 32 Updating Scripts in RateManager

6. Click File->Reload to refresh the system

In SQL Server

This method should be performed by a database administrator. No warning messages are displayed if
you execute scripts in the wrong order. You must know the name of the databases you are updating.
Please see Manual Updates to the Insbridge Database.

After you perform the database updates, to view all menu options, click File->Reload.
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STEP 8 — UPDATING PREFERENCES

Administrators can edit web settings at any time from the Preferences option in RateManager. Changes
will take place after the user sessions have been ended. If web settings are changed while the users are
inside the module, the change will not be visible to them. Prior to users accessing RateManager for the
first time, it is recommended that Preferences be set.

To Change Settings

1. Select Tools>Preferences. This opens the Preferences window.

2. Select System. This option is displayed only if you are an administrator.

| Preferences
-I-Settings A
S System Settings
- Home Page 9
-~ Administrator
System Insbridge Configuration File Path: |C:\F' ROGRAM FILESVORACLEVINS BRIDGE\FRAMEWORK‘&.S.U\NI
[ Impact Analysis Messaging
- Migrate Workfiles| sarver I.NET ﬂ |bca|host | {Secure Channal) I:‘
SoftRater Sarver : I.NET ﬂ ||Dc,a|host | {Secure Channal) D
Table Managament Massaging
Sarver (JAVA Only): | | Ezamazirme] D
WorkFiles Share Folder Location: | |
DB Backup Share Folder | |
Location:
Tzble Management Export I_
Include Asterisk for Blank Cells: Trus ﬂ
Table Managament Import Excal I_
Preview Rows: 5 ﬂ
Use Insbridge Com+ Admin: ITrue ﬂ
Enforce Releasa Packaging: IFaise ﬂ
Batch Package Threads: El
Minimum Login User ID Length:
User must change password: (D=ys)
Show Owverride Data Mask: ITrue ﬂ
Allow Datz Typa Changs: Trus ﬂ v
Inactive Session Time Qut: [hrs]
%  Save | @ Close |

Figure 33 Preferences Settings

3. Make any necessary changes. If you do not know all the settings, you can come back and edit at
a later time. It is recommended that you update the ONLINE HELP Server immediately.

4. When you are finished, click SAVE to update your settings. If you want to changes to take place
immediately, you may have to end all user sessions.
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System Setting Options
Insbridge Configuration File Path

The path of the configuration file found in IBFA. This pathway must match the IBFA path. You may need
to change this path if you have changed the path in IBFA. Please contact Insbridge support for further
information.

Itis strongly recommended that you leave the default.

Impact Analysis Messaging Server

Impact Analysis is set up to run on the same server where RateManager is located. The Impact Analysis
Messaging Server setting allows for select SoftRater instances to be used when running scenarios
through Impact Analysis. Only an Insbridge SoftRater Server (IBSS) utilizing an Oracle database can be
entered. When an IBSS instance utilizing an Oracle database is entered, the environments on the
instance will populate Impact Analysis and Impact Analysis will query against the Oracle database. If an
IBSS utilizing another database type is entered, no environments will be populated.

To use and IBSS instance with an Oracle database, select the server type Java (For SoftRater for
Apache TomEE) and enter the IBSS URL.

If localhost is used, Impact Analysis runs queries against the disk where batch files are stored. The server

type must remain .NET. The default value is to remain on the RateManager server.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Table Management Messaging Server (JAVA ONLY):

Table exports require a Java instance. If you want to use the Table Management feature, you must enter
an Insbridge Java server location. Format requires the port number being used but does not require
preceding slashes. DNSname:port or IPAddress:port

If you do not enter a valid Insbridge Java server location, table exports will not work.

Work Files Share Folder Location

A shared Workfiles location allows for multiple instances of RateManager to share the same Workfiles.
The Insbridge server and the shared location must be on the same domain. The Insbridge user must be
on the domain also.

For instructions on setting up a WorkFiles Share Location, please see the Insbridge WorkFiles Installation
Guide onthe https://docs.oracle.com/en/industries/insurance/index.html
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DB Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the backup file. If
the location is local, use a local path. If the location is not local, you must be a disk admin to change.

If the database is on a remote server, a share is needed for the backup location. The Insbridge user must
have write access to this location as well.

Table Management Export Include Asterisk for Wildcard

When the Table Management Export Include Asterisk for Wildcard option is set to True, an asterisk is
inserted for wildcard null values. This is automatic in tab-delimited exports. For Excel exports, the option
is activated but can be overridden.

Table Management Import Excel Preview Rows

Select the number of rows available for preview when importing table data from MS Excel. Available in
increments of 5, 10 or 20 rows.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full) package. False
is the default setting.

If setto True, a release is required in order for a SoftRater (full) package to be created. If a user wants to
create a SoftRater (full) package in the Program Explorer module, a release must be created in the
Releases area first. This release must have the program added to it and be unlocked. When the user
creates the SoftRater package in Program Explorer, they will have the option to select the Release they
want this package to be placed into. If there is no release, or no release that contains that program and is
unlocked, then the user will be able to do RateManager (local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to finish
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor
systems, using multiple threads enables the operating system to assign the threads to different
processors.

In addition, the Framework Administrator also enables you to change the administrator email address for

each client. When a process fails, an email will be sent to the person who initiated the process, as well as
to the administrator email addresses listed for the client of that process.
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NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Oracle Insurance recommends a maximum of 2 threads.

Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password. This setting
will only be active when you elect to have users change their password on the user setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this
field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and string)
data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True allows RateManager users change the data type of a variable or input. Setting
this option to False does not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting places a
carriage return between result files. A False setting results in one continuous string without a break.

Online Help Server

Online help is installed with RateManager. This setting is the default server name where RateManager
currently resides. Either a server name or an IP address can be entered here. If needed, you can change
the name of the server. For example, if the machine name is not the same as the host name, you may
need to change the name in order for online help to function.
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My Recent List

My Recent List is a snap setting. Snaps are modules that contain information or links to elements that the
user recently worked on. You can set the maximum number of elements to display in a snap. The default
is for the snap list to be limited to 10.

Default Proxy Script Location

The Default Proxy Script Location setting may be needed if you elect to use the Oracle Insurance Blog
Feed snap. This setting can be used for RSS feeds.

Change Control

If change control is on, it is mandatory for users to enter a change control entry and justification to any
element or program when it is revisioned. If change control is off, the option is not presented.

Maximum Amount of Simultaneously Opened Tabs

Use the maximum amount of simultaneously opened tabs setting to set the maximum number of tabs you
allow users to have opened in RateManager. The default is 15.

Debug Report Format

Select the debug report format to be used in the Test Program section of RateManager. Debug reports
can be a single report format, where the entire report is listed out or in a summary report format where
information is contained in sections that can be expanded and collapsed. Summary report format may be
useful if large programs are to be run. This setting can be updated at a later time.

Default Naming Standard

Select the Naming Standard to be applied system. If a Naming Standard is not needed system wide, clear
the field. The default is for the system default to be used. Please see Naming Standards for more
information.

Enable Worksheet for Test Case Editor

Select true to have the option to create a rating or calculations worksheets in Test Case Editor. Select
false and the option to create a worksheet in Test Case Editor is not presented. Please see Worksheets
for more information.

Product Configuration Server

Enter in the location of Product Configuration. Product Configuration (PC) is a business modeling tool that
allows you to create a reusable hierarchical schema that defines your insurance products. An entry in
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this field enables the PC domain type and allows for updates to be brought in to RateManager. Leaving
the field blank disables the PC domain type.

Enforce Product Configuration

This option mandates that all content come from Product Configuration. Product Configuration (PC) is a
business modeling tool that allows you to create a reusable hierarchical schema that defines your
insurance products. When set to true, only the PC domain type is available, The RateManager or Other
domain types cannot be used.

Reporting Threads

Enter the number of threads to be used for reporting. The field is initially blank and the system will default
to a single thread. Entering a value higher than the default may result in better system performance.
Reports may run faster as you approach an optimal thread count. The thread count is based on the
hardware capabilities (number of CPU cores and memory) of the server. A high thread number does not
necessarily warrant a faster performance. You should analyze how much data you need to process and
the capabilities of your server to get to an optimal number. A value does not have to be set.

Global Versions Report Threads

Enter the number of threads to be used for global version reports. The field is initially blank and the
system will default to a single thread. Entering a value higher than the default may result in better system
performance. Reports may run faster as you approach an optimal thread count. The thread count is based
on the hardware capabilities (number of CPU cores and memory) of the server. A high thread number
does not necessarily warrant a faster performance. You should analyze how much data you need to
process and the capabilities of your server to get to an optimal number. A value does not have to be

set.

Upgrade Guide 51



STEP 9 — UPDATING GROUP RIGHTS

If you are upgrading from a release prior to 05.00.01, you will need to update permissions. A new schema
was introduced in 05.00.00. It contains new levels within RateManager and changes to permissions.
Previous settings will be carried over but new levels require that administrators update permissions.

New features have also been added that require permissions to be set. Administrators will have
permissions automatically assigned.

To Update Rights

1. Navigate to the Tools—> Security=> Group Management tab and select the group whose rights you
want to edit. Click Rights.

2. The Group Rights window is displayed.

=% RateManager Table Job Admin - Access Granted

----- & [« ImportExport Management
=% RateManager Domain Admin - Access Granted

----- & [+] Product Management

----- & [¢] Project Management

=& RateManager Universals - Access Granted
"[f'] Variables

@ [7] Algorithms

& [V Fields

--ﬁ Categories

- [v] Vvalid values Management
&[] Scenarios
- RateManager Testing - Access Granted (W]

H-& RateManager Package Admin - Access Granted

2  Save | 3 Close |

Figure 34 Assigning Group Rights

3. Changes torights:
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a. Universals is a new level in RateManager. Universal rights allows users to manage
elements for the project level. Also at this level is categories and field inputs. Without
universal rights, users will not be able to create field inputs or manage categories.

b. Domain admin rights have updated rights. To select products for projects, users must
have both project and product level permissions. Users may have these rights if they
previously had line and subline rights.

c. Table Job Admin is a new feature that allows users to export table data into an Excel
workbook. Permissions must be granted to allow users access to Table Job
Management, to edit, delete and start jobs.

d. Valid Values Management is a new feature in Universals that allows users to create, edit
and delete validations in any domain.

e. Valid Values Revision Selection is a new feature in the product permissions that allows
users to select the active revision of a validation.

f. Scenario Managers is a new feature that allows users to create, edit, and delete
scenarios. Scenarios hold selected tables from selected programs. Scenario Managers
also need permissions in the products that are to be added to scenarios.

g. Scenario Users is a new feature in the product permissions that allows the user to edit
the tables that have been added to a scenario.

h. Users with releases rights now require product rights as well. Programs cannot be
selected for a release unless the user has rights to the product where the program
resides.

For more details on rights, please see the RateManager User Guides Tools Menu.

Assign rights to the group as needed. Expand the appropriate section and place a check next to
an item to give the group access to that section.

Scroll through the rights and verify that the group has the rights that are required.

When you are finished making changes, click Save.
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STEP 10 — SEND NOTICE TO RM USERS TO CLEAR |IE

Some users may experience issues with RateManager after an upgrade. This may be due to temporary
internet files remaining in cache. These files are called and since they are not compatible with the newer
version of RateManager, an error message is displayed.

This issue may be a more prevalent with users upgrading from a 4.9 release or earlier.

Upgrading from Previous RateManager Release

If you experience issues where RateManager is not functioning properly, temporary RateManager files
being held in Internet Explorer may be the cause. This issue may be presented for users who are
upgrading to Insbridge 5.x from earlier versions. In this case, it may be necessary to delete the temporary
internet files in Internet Explorer. Removing temporary RateManager files will clear all cached files and
assures that only the latest RateManager files are used.

Delete browsing history and uncheck the option to Preserve Favorite website data.
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Preserve Favarttes webrute dota
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Bt yur wat, ad exosgtons 1 Do Mot Track reguests.
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Make sure that “Preserve Favorites website data” is not selected when deleting the temp internet files. If
the RateManager website has been added as a Favorite, then the temporary internet files for RM are not
deleted.
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OPTIONAL STEPS
There are optional steps that can be performed for a RateManager/IBFA update.
Migrating Files
e Step 1: Migrate Files
e Step 2: Update Portal URL

These steps may not be required, depending upon the actions you want to take.

MicraTE WoRK FILES

This option migrates workfiles from previous versions of RateManager. This procedure is for updates from
release 4.8 or previous or if you are updating to a new machine.
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STEP 1 — MIGRATE WORK FILES

Migrating workfiles assures that previous workfiles are available to users. Workfiles are rating, pricing,
mapping and template files used in various areas of RateManager such as Impact Analysis, Library, and
Testing. Migrating files allows users to access work files that were available in previous releases of
RateManager. If you do not migrate work files from previous versions, users will not have access to them.

Work files should be migrated after the upgrade has been run.

o oty Docueenas__________________________________________________________ AEO
Fle [dt Yew Frooites Took  Help -4
+ = @ = (F | seach |5 Poiders | [F3-
Address ) My Docuents =B
Fokers x| Moms - l S | Typs | Dot Mocfied
= e Lowal Disk(C5) =l
¥ E s b0 TAS TR g SEs
# | Docurmens and Settng:
& | Dosnboads
# D 1=
= I betpub
() Dbk ackagel g stion
= I Program Files
B ) omek
# [0 Ciwewnon Files
0 ComPhu Apple stions
= [ InsBridge
) SO
W 115 Pramessork.
% 0 5o
= I Softfate
= 1L ‘Webs

= The location of previous RatetManager installations:
# () mAu

) RM310 - 1 Program Files\InsBridoe\Webs\RMuoo:

# 2 pMn2 wiherne wood exquats the version number

) Iribsrvesd Exponer

B

The location of previous RateManager installation:
Program Files\Oracke\ IGBUN Inshridage Webs R4

o bud JET] 2

Figure 35 Location of WorkFiles

Prior to migrating files, please create backup copies of the files to be migrated. This requires access to the
server were RateManager has been installed.
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Migrating files is a two-step process.

Step 1: Locate the previous workfiles to be migrated.
The location of the files to be migrated and the exact file name will depend upon what version of
RateManager you want to migrate. There are four possible locations.
For Release 3.12 and earlier:
e File Name: WorkFiles
e Location: \Program Files\InsBridge\Webs\RMxxx\WorkFiles
Where xxx is the version number, i.e. 310, 311, 312
For Release 3.13:
e File Name: Workfiles
e Location:\Program Files\Oracle\IGBU\Insbridge\Webs\RM313\Workfiles

For Release 4.0 To 4.8:
e File Name: Workfiles
e Location:\Program Files\Oracle\IGBU\Insbridge\Webs\RM4\W orkfiles

For Release 4.9:
Use only if moving to new server.
o File Name: Workfiles
e Location: \Program Files\Oracle\Insbridge\Webs\RM4\Workfiles

Copy all work files for every version to be migrated and store in a safe location. In the unlikely
event that an error with the migration occurs, you will have backup files that you can place directly
in the RateManager (RM4) Workfiles location or restore to the previous version.

Step 2: Place copies in the new workfiles location.
New File Location
o File Name: Workfiles
e Location: \Program Files\Oracle\Insbridge\Webs\RM4\W orkfiles

Manual Migration

Migrations must be performed manually. If you are working with two separate machines, you must
perform the migration manually. If you have more than one version where you want to migrate files, you
will have to perform the migration manually.

DO NOT USE RATEMANAGER TO MIGRATE MULTIPLE VERSIONS. Only one version can be
migrated. If you attempt to migrate more than one version, you will write over any data with the version
that you are migrating. For example, if you migrate version 3.12 and then migrate 3.13, any information
from 3.12 will be written over with the information from 3.13. If you have more than one version to
migrate, you must perform the migration directly on the server.

Verifying the File Migration in the Server

Migrated files will be moved from previous releases into the updated location - \\Program
Files\Oracle\Insbridge\Webs\RM4\W orkfiles.
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Figure 36 Verifying File Migration at Server Level

You can verify that files have been moved by looking in the

\Program Files\Oracle\Insbridge\Webs\RM4\W orkfiles folder.

You also can verify that previous WorkFiles have been removed by looking in the prior WorkFiles location

on the server. Workfiles only need to migrated one time.

Verifying Migrated Files in RateManager
Migrated files are available in the same areas.

To verify that work files from a previous version have been migrated, enter an area where these files
would be used, such as the Library tab.

The tab refreshes with all available files. Your files from previous versions will be listed.

NOTE: Previous export files should not be migrated. Previous export files are not recognized in current
releases of RateManager.
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UPDATE PORTAL URL

The Oracle Insurance Insbridge Enterprise Rating Portal (Portal) is a single point of access to the Oracle
Insurance Insbridge Enterprise Rating (Insbridge) system. If you are using a portal, the URL must be
updated to reflect to new application pool settings. The previous extension of IBRU will not work.

The portal can now be accessed from http://LOCALHOST/insbridge
Where: LOCALHOST is the server where the Insbridge system is installed.

To Update

Step 1: Locate previous portal settings.

Step 2: Copy from previous portal to new portal.
Step 3: Update URL to insbridge
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Figure 37 Portal Locations
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Step 1: Locate previous portal settings.

The location of the files to be copied and the exact file name will depend upon what version of
RateManager you want to copy. There are three possible locations.

For Release 3.12 and earlier
e File Name: Xml
e Location: \Program Files\InsBridge\Webs\IBRU\XmI
For Release 3.13t0 4.8.X
e File Name: Xml
e Location: \Program Files\Oracle\IGBU\Insbridge\Webs\IBRU\XmI
For Release 4.9.X
Use only if moving to new server.
e File Name: Xml
e Location: \Program Files\Oracle\insbridge\Webs\IBRU\Xm
Copy all four XML files and store in a safe location. In the unlikely event that an error occurs, you will have
backup files that you can work with.

Step 2: Copy from previous portal to new portal.

New File Location:
e File Name: Xml
e Location: \Program Files\Oracle\Insbridge\Webs\insbridge\Xml

Step 3: Update URL to insbridge to reflect the application name of insbridge.

Portal Security

Security has been added to the Insbridge webs. A valid username and password will be required to
access the portal unless Windows Authentication has been turned off. If Windows Authentication has
been turned off, users will be required to log in to RateManager with their username and password. To
allow access to the portal without requiring a login, users must be network users on the machine where
Insbridge is installed.

Portal Access
The portal can be accessed from http:/LOCALHOST/insbridge

If you wish to re-create the portal or want more information, please the Insbridge Enterprise Rating Portal
Configuration Guide.
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UPGRADING TO A NEW MACHINE

If you are upgrading RateManager/IBFA from any previous release AND moving to a different machine
you will need to perform these steps. These steps will allow any packages loaded to the old machine to
be loaded and used by the new machine. If you do not perform these steps, old packages may not rate
properly or even be available to users.

NOTE: These steps need to be done only when you are migrating your RateManager/IBFA instance
from an old machine to a new machine.

Step 1: Install RateManager/IBFA

Step 2: Export the Insbridge Registry Key from the old Machine

Step 3: Import the registry key from the old machine to the new machine
Step 4: Copy the Insbridge XML file from the old machine.

Step 5: Paste the Insbridge XML file in the new machine.

Step 6: Finish the Installation

Step 7: Run any needed Database Client — Optional

Step 8: Manually Migrate Workfiles

Step 9: Update Portal if necessary

Step 10: Send notice to RM users to completely clear cache, including Preserve Favorites website
data.

After these steps, your RateManager/IBFA should be ready for use.

Step 1: Install RateManager/IBFA

A RateManager/IBFA upgrade that involves moving to a new machine is considered a new install. Please
follow the instructions for installing RateManager/IBFA in the RateManager Installation Guide.

STOP At Step 7 — Configuring Insbridge Framework Administrator.
Do not create a subscriber or environments.

Step 2: Export the Insbridge Registry Key
The Insbridge registry key located in HKEY_LOCAL_MACHINEOSOFTWAREUInsbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs).

When RateManager/IBFA is re-installed on a new server, a new registry key will be created. The new
registry key will not match the registry key associated with any packages that have been created on the
old machine. In order to load packages to the new machine, you will need to restore the previous registry
key.

On the old machine, enter Registry Editor. Run->regedt32.

Selectthe Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.

Right click and select Export.

Select a storage location for the file and Save.

Close out of Registry Editor.

agrwnpE

Step 3: Importing the Registry Key

The old registry key needs to be imported in to the new machine.

1. Savethe Exported Registry Key to a location you can easily access.
2. Doubleclick the Exported Registry Key. The key will be loaded.
3. Store the Exported Registry Key in a safe location.

Step 4: Copy the Previous Insbridge. XML File
You can copy and paste the Insbridge XML file from the old machine to the new machine. This will allow
the environments and subscriber created in the old machine to be populated in the new machine.
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NOTE: If you want to re-enter or re-create your environments, you can skip Step 4 and Step 5. After you
import the registry key, you will need to continue the RateManager/IBFA installation at Step 7 —
Configuring Insbridge Framework Administrator.

File Location
The location of the Insbridge.XML file to be copied will depend upon what version of RateManager the old
machine is running. There are three possible locations.

For Release 3.12 and earlier:
e File Name: InsBridge. XML
e Location: D:\ProgramFiles\InsBridge\Framework\2.0.2\InsBridge.Xml.
OR C:\Program  Files\Oracle\insbridge\Framework\2.0.0\Insbridge.Xml

For Release 3.13t0 4.8.X:
e File Name: InsBridge. XML
e Location: C:\Program Files\Oracle\IGBU\Insbridge\Framework\3.5.0\Insbridge.Xml

For Release 4.9.X:
e File Name: InsBridge. XML
e Location: C:\Program Files\Oracle\Insbridge\Framework\4.5.0\Insbridge.Xml

Copy the Insbridge. XML file to a location you can easily access.

NOTE: If you are changing databases, you can copy and paste the Insbridge XML file, however you will
need to update your environments with the new database information.
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Figure 38 Previous Config.xml file Location

Step 5: Paste the Insbridge. XML File
Before pasting the Insbridge. XML file into the new location, make a copy of the blank Insbridge. XML file
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and store in a safe location. In the unlikely event that an error occurs, you will have a backup file that you
can use.

The Insbridge. XML file in the New Machine is located:

C:\Program  Files\Oracle\insbridge\Framework\4.5.0\Insbridge.Xml

1. Make a copy of the blank Insbridge.XML file on the new machine and store in a safe location.

2. Paste the Insbridge.XML file from the old machine in to the new machine in the same location.

3. Open an Internet Explorer web browser either remotely on the local Insbridge web server and
browse to IBFA location on the new machine: http://SERVERNAME/ibfa/

4. Subscribers and Environments should be available in IBFA on the new machine. Verify your

entries.
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Figure 39 New Config.xml File Location

Step 6: Complete the RateManager/IBFA Installation
Complete the instructions for installing RateManager/IBFA. Please see the RateManager Installation
Guide for detailed instructions.

Continue at Step 8 — Verifying the Component Services. You will need to complete the rest of the

installation.

Step 7: Run Database Clients — Optional

This step is optional. You will need to run the Oracle Client if you are utilizing a Java SoftRater, i.e. SoftRater
for Apache TomEE. The Oracle Client is located in the Oracle Cloud Delivery package for 5.6.0. For
instructions on running the Oracle Client, please see the corresponding SoftRater Installation Guide, i.e.
SoftRater for Apache TomEE Installation Guide.
Please make sure you use the 64-bit client.
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Step 8: Manually Migrate Workfiles
After the installation has been completed, you will need to migrate workfiles. Follow the instructions for
Manually Migrating Workfiles, see page 73.

Step 9: Update Portal Settings
If an Insbridge portal is being used, the URL and security settings may need to be updated. Follow the
instructions for Updating a Portal, see page 76.

The RateManager system is ready for use.

NOTE: If users experience any difficulties with migrated packages, please verify that the database
usernames and passwords are entered for any SoftRater environment.

Step 10: Send Notice to RM Users to Clear IE
Some users may experience issues with RateManager after an upgrade. This may be due to temporary
internet files remaining in cache. These files are called and since they are not compatible with the newer
version of RateManager, an error message is displayed.

This issue may be a more prevalent with users upgrading from a 4.9 release or earlier.

Display Issues When Upgrading from Previous RateManager Release
If users experience issues where RateManager is not functioning properly, temporary RateManager files
being held in Internet Explorer may be the cause. This issue may be presented for users who are
upgrading to Insbridge 5.x from earlier versions. In this case, it may be necessary to delete the temporary
internet files in Internet Explorer. Removing temporary RateManager files will clear all cached files and
assures that only the latest RateManager files are used.

1. Addthe RateManager URL to the Favorite web address.

2. Delete browsing histo.rlgnd uncheck the option to Preserve Favorite website data.

Delete Bromsng Mitory

Preserve Favartes webute dota
Coer oy wd e @ ;Ui ret Sy Tt eatee v toote
et vt prefe erues o Geagphe g faster

< Temporary laterset Shes and webae ey
Cooms o eatragee mages, and Tede $a? &e et fo ‘wrer
conrg

Pies or databanes $ored on your Computier by setuies & teve
I eteences v Oy vt welm e fe S e

wtory

Wt O D o N s

Cnrpndosd testory
2! e v hare Srrratet

form data

Saved rdormation St you heve tped o fares

Portmirts
Cav Daeor 3 St we asDmancaly e 1 e (o 3N
16 & wedete v, vo (resonaly vaed

Trackieg Protection, ActrveX Fitering and Do Sot Track
AT of watmtns uchaind Yom Mereg, data woed Oy Tracwg
Pecipcon V2 detrct stere 3ira S as et sty be g delsh
et yiur wat, ad excegtons 1 Do Mot Track reguests

[ Carcwt

Make sure that “Preserve Favorites website data” is pgt selected when deleting the temp internet files. If
the RateManager website has been added as a Favorite, then the temporary internet files for RM are not
deleted.
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IMPORTING REGISTRY KEY AFTER INSTALLATION

The registry key can be imported at any time after the initial RateManager/IBFA install and subscriber
creation. If the registry key needs to be imported after you have completed the installation and set up your
SoftRater environments, you will need to re-enter Database Username and Passwords for the SoftRater
Environments.

This procedure is only required if you have configured your environments. If you have not configured
your environments, you should not have to re-enter usernames and passwords for your environments.

Prior to starting, IBFA should be up and running on the new machine.

Step 1: Export the Insbridge Registry Key
The Insbridge registry key located in HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge is used to
store all information for proper encryption of the SoftRater Packages (SRPs).

When RateManager/IBFA is re-installed on a new server, a new registry key will be created. The new
registry key will not match the registry key associated with any packages that have been created on the
old machine. In order to load packages to the new machine, you will need to restore the previous registry
key.

On the old machine, enter Registry Editor. Run—->regedt32.

Selectthe Insbridge key: HKEY_LOCAL_MACHINE->SOFTWARE->Insbridge.
Right click and select Export.

Select a storage location for the file and Save.

Close out of Registry Editor.

agrwnE

Step 2: Importing the Registry Key
The old registry key needs to be imported in to the new machine. The registry can be imported using
IBFA.

1. Savethe Exported Registry Key to a location you can easily access.
2. Doubleclick the Exported Registry Key. The key will be loaded.
3. Store the Exported Registry Key in a safe location.

Step 3: Re-enter Username and Password

Enter the new IBFA instance.

Browse to SoftRater>Explorer>Subscriber name.

Select the Environments link under the Configuration header on the left hand side.

You will notice that the database username and password entries will be blank. Please re-enter
the username and password. Test connections for any SoftRater environments.

Save your entries and close out of environments.

N

o

Upgrading the Database Machine
If you are upgrading your database machine, the new database information will need to be entered in
IBFA->Environments.

Upgrade Guide 65



MANUAL UPDATES TO THE INSBRIDGE DATABASES

The preferred method of updating the ibrm, and ib_client databases is run them through ratemanager. If the
administrator has db user privileges and is the db owner of the database as well as the disk administrator,
database updates can be done on the tools — database — updates tab. If these privileges are not in place,
an error message is displayed. See

Step 7 — Updating Databases for more information.

NOTE: If you need to go from an older version, such as 5.0.1, it is strongly recommended that you enter
RateManager and run the script successively starting with 05.02.00, 05.03.00, and so on until you
reach the 5.6.1 script. Failure to run scripts in order may result in errors.

To manually update a SQL Server database, you will be required to save off each update and run them in
sequential order in SQL Server. A DBA or a person with the proper permissions will need to apply the
database updates in SQL Server using Query Analyzer.

1. InRateManager, go to Tools->Database->Updates.

2. Select the update you need. Begin with the version that is listed as Current. If you are going from
a much lower version of RateManager, you will have to save multiple files.

3. Click Save Update Script to File. Your computers dialog box is displayed. Save the file to a
location of your choice. For IBRM scripts, it is recommended that you rename the file to
usp_IBRM_RO(version number).sgl. For example the release 5.6.1 update would be:
usp_IBRM_R05.06.01.sql. For IB_CLIENT scripts, it is recommended that you rename the file to
usp_IB_CLIENT_RO(version number).sqgl. For example the release 5.6.1 update would be:
usp_IB_CLIENT_R05.06.01.sql.

4. Verify that you have saved all the necessary scripts from “current” to release 5.6.1. You must
save off update scripts for both the IBRM and the IB_CLIENT databases.

5. Next, enter SQL Server.

NOTE: If you do not have database permissions, you will not be able to perform the following database
queries.

NOTE: When using Database Engine Query, the SQL scripts must run on each individual database.

6. Begin with the current version of either the IBRM database or the IB_CLIENT database. Open
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Query Analyzer

Open up the DB script updates from the download file. You can open in any program you want,
such as Notepad. Begin with the “current” script. For example, if you are going from release 5.0.1
t0 5.6.1, 05.01.00 should be “current”. Open 05.02.00 first.

R Microsoft SQL Server Management Studio

File | Edit Wiew Tools ‘window Community Help

2. connect Object Explorer.. | Sl d @B BBk,

I 4 Disconnect Object Explorer

‘ Object Explorer Details | - X

| Dlew

Project... Ctrl+Shift+M

open

Clse

i@ Savedl Clri+Shift+S [F  54L Server Compact Edition Query
Source Control 4 A Views
- L Synonyms
IEI [ Programmabilicy
[ Service Broker
Exit L Storage
T TERM_S10_TEMPLATE [ Security

. Query with Current Connection Chrl+

[ MARY

AIE_CLIENT_MARY 3 Ikem(s)

Database Engine Query

Ay Analysis Services DM Suery

"y Analysis Services ¥MLA Query I

=

Ly
{5y Analysis Services MDK Query
i

-

ut]

Figure 40 Updating Database

8. Select the database you want to update. In SQL Server Management Studio, create a new
Database Engine Query, File>New->Database Engine Query.

9. Copy the first update from Notepad and paste onto the query screen.

10. Click Execute. The script will execute. Any messages will be displayed in the lower portion of the
screen. You must run the updates in sequential order. Run each update until you run the
5.6.1 update.

11. When you have finished updating one database, update the remaining database. Make sure you
do both the IBRM and IB_CLIENT databases.

12. After the scripts have been run, return to RateManager. Click Refresh Listing. The status should
show current and the full RateManager menu should be displayed. The updates are now properly
applied and users can log back in to the system.

NOTE: You can view the update script in RateManager. Select the update you want to view. Click Open

Update Script. The update script will be displayed in a separate screen.
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1 IBRE : v05.06.00.00 -- Webpage Dialog X

IF ((SELECT DATA TYPE FROM INFORMATION SCHEMA.COLUMNS WHERE TABLE NAME A
= 'PROGRAM VERSIONS' AND COLUMN NAME = 'VER') = 'int') m
BEGIN

/* DROP ALL THE PK, FK AND INDEX CONSTRAINTS RELATED TO PROGRAM VER */

ALTER TABLE [dbo].[TABLE MANAGEMENT JOB_DEFS] DROP CONSTRAINT
[PK_TABLE MANAGEMENT JOB_DEFS]

ALTER TABLE [dbo].[TABLE MANAGEMENT JOB_DEFS] DROP CONSTRAINT
[FK_TABLE_MANAGEMENT JOB_DEFS_PROGRAM VERSIONS]

ALTER TABLE [dbo].[PROGRAM VERSIONS KEYS] DROP CONSTRAINT
[FK_PROGRAM VERSIONS_KEYS_PROGRAM VERSIONS]

ALTER TABLE [dbo].[RELEASE PROGRAMS] DROP CONSTRAINT
[FK_RELEASE PROGRAMS_PROGRAM VERSIONS]

ALTER TABLE [dbo].[PROGRAM LOOKUE_VARS] DROP CONSTRAINT
[FK_PROGRAM LOOKUPVARS_PROGRAM VERSIONS] v

Figure 41 Script Viewer
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UPGRADING SOFTRATER FOR JAVA

The steps to follow for upgrading SoftRater for Java depends upon what Insbridge release you are
starting from:

Upgrading from Release 3.13.4 or previous to release 5.6.1 requires:
e Removal of the previous .EAR and config files

Deploying the new .EAR file

The application starting file must be updated

A New SoftRater database be created

Run database upgrade script

Packages must be re-loaded

Upgrading from release 3.13.5 to release 4.6.X to release 5.6.1 requires:

Removal of the previous .EAR file
Deploying the new .EAR file

The application starting file must be updated
A New SoftRater database be created

Run database upgrade script

Packages must be re-loaded

Upgrading from release 4.7.X to release 5.6.1 requires:

Removal of the previous .EAR file
Deploying the new .EAR file

A New SoftRater database be created
Run database upgrade scripts
Packages must be re-loaded

Upgrading from release 5.0.1 to release 5.6.1 requires

e Removal of the previous .EAR file
e Deploying the new .EAR file
¢ Run database upgrade script

If you are upgrading from release 3.12 or previous you should check for SOAP changes. Updated
WSDL documents will need to be incorporated into any client calling application that communicates
with SoftRater. If upgrades are done to the SoftRater for Java engines without updating the calling
applications, the calling application will fail.

NOTE: UPGRADE YOUR TEST ENVIRONMENT PRIOR TO PRODUCTION. Validate in test prior to
implementing in production.
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SoftRater Update Notice

If you are updating from release 5.0 or earlier, the SoftRater database has updated requirements:
Due to schema changes, all SoftRater databases for releases 5.0 and earlier must be created new.

For customers who are upgrading a SoftRater instance, new databases must be created for any upgrade
from release 5.0 and earlier. For new database upgrades, packages will have to be re-loaded to the new
database. Packages will still be available on disk.

UPGRADING IBSR — An Upgrade folder is located inside each of the database types with one upgrade
script and Instructions for running the update. When upgrading from a release prior to release 5.0. users
must create new and re-load packages.

Only one update script is available per database type. This script covers all updates from the last schema
change. This reduces the number of potential upgrade scripts users must run and assures that the scripts
are run in the correct order. Any script that has already been run will be skipped. This change allows for
easier management of IBSR update scripts.

SoftRater Machine Update

If you are updating SoftRater to a new machine, the process is a combination of a new install and an
upgrade.

e The old .EAR files do not have to be deleted. If the machine is decommissioned or is not
accessible, then the .EAR file is not available to users and does not need to be deleted. If the
machine is available, it is a good practice to delete the old .EAR file so users no longer can
access it.

« A new folder to hold the .EAR file, config file, and Instance directory must be created on the new
machine.

e The old config.xml file should be copied from the previous machine to the new machine. If you
use a new config.xml file, all the previous setup information will need to be re-entered in IBSS.

e Onthe new machine, the start files must be updated to allow for the APP_DIR and
INSTANCE_APP_DIR directories to be added.

e The same databases can be used. If upgrading from a release prior to 5.0.0, a new data base will
need to be created and update scripts will need to be run. Update IBSS with the new database
information. Packages will also have to be re-loaded. If you are upgrading from release 5.0.1 or
later, you do not need to do this.

e The updated server information needs to be entered in to IBFA.

For example, if you are upgrading from a 3.13 release to the latest and going to a new machine:

Upgrading from Release 3.13.4 or previous to release 5.6.1 and moving to a new machine:

If possible, removal of the previous .EAR and config files

Create a folder for the .EAR file, config.xml file, and Instance directory
Copy the previous config.xml file to the new machine

The application starting file must be updated

In the new machine, deploy the new .EAR file

A New SoftRater database must be created

Run database upgrade script

Packages must be re-loaded

New machine information must be entered in IBFA
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SOFTRATER UPDATES

The SoftRater for Java engines is Apache TomEE

The upgrade procedures to the application are similar and the upgrade procedure for the associated
databases is the same.

SoftRater Update Notice

If you are updating from release 5.0 or earlier, the SoftRater database has updated requirements:
Due to schema changes, all SoftRater databases for releases 5.0 and earlier must be created new.

For customers who are upgrading a SoftRater instance, new databases must be created for any upgrade
from release 5.0 and earlier. For new database upgrades, packages will have to be re-loaded to the new
database. Packages will still be available on disk.

UPGRADING IBSR — An Upgrade folder is located inside each of the database types with one upgrade
script and Instructions for running the update. When upgrading from a release prior to release 5.0 users
must create new and re-load packages.

Only one update script is available per database type. This script covers all updates from the last schema
change. This reduces the number of potential upgrade scripts users must run and assures that the scripts
are run in the correct order. Any script that has already been run will be skipped. This change allows for
easier management of IBSR update scripts.

SOAP Notice
This notice is for customers currently running a SoftRater for Java engine. Necessary updates have been
made to the SoftRater for Java engines:

o SoftRater for Apache TomEE uses SOAP version 1.1.

These changes mean that the WSDLs for the SoftRater for Java engines may have been modified since
the last installation of SoftRater for Java. Updated WSDL documents may need to be incorporated into
any client calling application that communicates with SoftRater. If upgrades are done to the SoftRater for
Java engines without updating the calling applications, the calling application will fail.

Please update a test environment prior to deploying to production. Install the .EAR file in a test
environment to obtain the WSDL. Update your calling application and then test again. When testing is
complete, you can upgrade your other environments.

NOTE: Customers running a Windows only environment, without a Java component, will not be affected.

These updates are for the SoftRater for Java engines only.
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SOFTRATER FOR APACHE TOMEE

SoftRater for Apache TomEE can be upgraded any time after the Insbridge system. Prior to upgrading,
download the SoftRater for Apache TomEE Engine Setup file.

Place the contents for the release 5.6.1 in a location you can easily access.
The file content include:

e |BSS.ear
¢ Insbridge.net.softraterconfig.xml

Upgrading to 5.6.1

This upgrade requires the creation of an Instance folder. The Apache TomEE configuration information

need to be updated for new SoftRater information. However, the softrater insbridge.net.softraterconfig.xml
need not be re-entered in IBSS.

To upgrade to the latest version, follow the Insbridge Enterprise Rating Using Batch Rating guide to
perform the following:

e Setting up Apache TomEE

Copy new or upgrade (Existing insbridge.net.softraterconfig.xml) file to configured directory.
Configuring HTTPS for secured protocol usage

Set up Clustering if required.

Soft Libraries re-configuration in the new Apache TomEE instance

Configuring JMS Queues
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SOFTRATER UPDATE NOTICE

If you are updating from release 5.0 or earlier, the SoftRater database has updated requirements:
Due to schema changes, all SoftRater databases for releases 5.0 and earlier must be created new.

For customers who are upgrading a SoftRater instance, new databases must be created for any
upgrade from release 5.0 and earlier. For new database upgrades, packages will have to be re-
loaded to the new database. Packages will still be available on disk.

Database User Roles and Permissions
If a more granular approach is required for management of security of the Insbridge databases,
then the following guidelines can be used to set permissions.

NOTE: These are only guidelines. If not properly configured, certain processes within the
Insbridge Enterprise Rating System will fail. An experienced database administrator’s expertise
is highly recommended before making any security changes.

Recommended SoftRater Permissions:

The recommended permissions are required for new tables to be created in the SoftRater (IBSR)
database dynamically when an SRP (SoftRater Package) is loaded to the SoftRater system. If the
recommended permissions are not possible, manual steps will need to be performed that will allow
for packages to be loaded.

Insbridge SoftRater can utilize Oracle database. It is recommended that the Insbridge user be granted,
as defaults, the “CONNECT” and “RESOURCE” Roles.

Updating a SoftRater Database
All SoftRater databases can be checked for updates in IBFA.

1. SoftRater->Explorer->Subscriber->Settings->Environments.

2. Select the SoftRater environment with the database where you want to check for
updates.

3. Click Test Environment.
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DRACLE Insurance Insbridge Framework Administrator
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Figure 45 Checking for Database Updates

When the database is being validated, either a green checkmark is presented or an error

message. The error message will indicate if an update must be run. For example, when validating
an Oracle environment:

F ™

The system was able to successfully connect to the database, but an
error occurred when trying to access the environment tables: The
systern is able to successfully connect to the configured envirenment,
however the DOL scherna is not valid. Please execute the DDL scripts
for the current release and try your request again. If your database is
upgraded to 5.0 please run the (oracle_schema_change) script on the
schema.. Please check the Windows &pplication EventLog for more
details.

Figure 46 Oracle Database Update Required Message

DDL scripts for updates also can be found on the server where Insbridge was installed in the
...\Oracle\Insbridge\SoftRate\DDL folder.

For example: C:\Program Files\Oracle\Insbridge\SoftRater\DDL\Oracle\Update
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Figure 47 Location of Database Update Scripts

For SQL Server, backup files are included in the Insbridge-Windows folder under databases.

If backup files cannot be used and DDL scripts are needed, SQL Server DDL scripts can be
found on the server where Insbridge was installed in the ...\\Oracle\Insbridge\SoftRate\DDL\SQL

folder. For example: C:\Program Files\Oracle\Insbridge\SoftRate\DDL\SQL

SQL Server DDLs are not included in the Insbridge-Windows folder.
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Oracle
SoftRater database schema is support by all available ORACLE database platforms.

JDBC Driver Class

“oracle.jdbc.driver.OracleDriver” Using
prefix jdbc:oracle:thin:

Supported Versions —11g, 12c, 19c¢c
User Account Requirements

Create Table Create
Index
Query access to “SYS.OBJ$”

Configuration Settings

e Required
The query dynamics of the SoftRater system requires some modification to Configuration
settings. The following Performance Configurations parameters required to the target
SoftRater database.
Instance Level — ASLHEAPSZ >= 1024 Instance
Level - QUERY_HEAP_SZ => 10240 Database
Level - APPLHEAPSZ >= 1024

e Recommended

The query dynamics of the SoftRater system will benefit from the following modification to
Configuration settings.
Instance Level — INTRA_PARRALLEL (Yes) — For Symmetrical Processing Machines
(CPU >=2)
Database Level - DFT_DEGREE (-1) — For Symmetrical Processing Machines (CPU
>=2). Allow the optimizer to determine the degree of intra-partition parallelism based on
the number of processors and the type of query.

UNIX Environment
1. Create a new script file called setenv.sh under the $CATALINA_HOME/bin directory with the
following contents:

setenv.sh

export JAVA OPTS="-Dfile.encoding=UTF-8 -Xms256m -Xmx2048m -

XX:PermSize=256m -XX:MaxPermSize=1024m"

e Xms: This is the initial and minimum Java heap size in megabytes. By default, there is no
value specified for this field. The heap is basically the memory space which holds all the
objects created by your application.

o Xmx: The maximum Java heap size in megabytes. By default, the maximum heap size
value is 256 MB.

e XX:PermSize: This is the initial size for permanent generation (or perm gen). It is the place
where Apache TomEE caches classes and other resources in the memory.

¢ XX:MaxPermSize: The maximum permanent generation size.

2. Save the file and then restart the Apache TomEE server to apply the changes.

Windows Environment
1. Create a new script file called setenv.bat under SCATALINA_ HOME/bin directory with the
following contents:
setenv.bat
export JAVA OPTS="-Dfile.encoding=UTF-8 -Xms256m -Xmx2048m -
XX:PermSize=256m -XX:MaxPermSize=1024m"
2. Once the file is created successfully, restart the Apache TomEE server to apply the changes.
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CREATING AN APPLICATION PooL

If the Insbridge application pool needs to be created, you can create one. The Insbridge

installation must be complete prior to creating an application pool. Make sure that Static Content
is enabled in the Server Manager Roles.

There are three steps to creating an Insbridge application pool and then assigning the virtual
directories.

e Step 1: Create or Verify an Insbridge Application Pool.
e Step 2: Verify settings.

e Step 3: Associate the Insbridge application pool with virtual directories IBFA, insbridge,
RM

Step 1: Create or Verify an Insbridge Application Pool
1. Click Start > Administrative Tools = select IS Manager.

2. Expandthe Local Computer and select Application Pools. Right click and select Add
Application Pool.

™ Internet Information Services (115) Manager =

@ L= ) [.3 ¥ SERVER * application Pools

& @

File  Wiew  Help

> e lication Pools _
<, - = | | | & gl App L= Add Application Poal...
= -5‘3 Start Page Set Application Poal Defaults, ..
=43 SERVER This page lets vou wiew and manage the list of application pools on the server, Application pools are associated with worker i T
| £ o otain one o more applications, and provide isolation amang different applications. ._@ Help
e .-, Add Application Poal... o
@] Sites —_—] - [0 Ge - Ghshaw Al | Groupby: mo Grouping - Orline Help
M3 FRefrash | status [ .MET Frame... | Managed Pipeli... | Identit | Applications |

;!ASP.NET w40 Started w40 Integrated ApplicationPoolIden... 0
QASP.NET v4,0 Classic Started w40 Classic ApplicationPoolIden... 0
2} Classic .MET appPaol Started w20 Classic ApplicationPoollden... 0
QDeFau\tnppPoo\ Started w2.0 Integrated ApplicationPoollden... 2

Ready L=

Figure 48 Navigating to Application Pool

3. Enter “Insbridge” for the Application pool Name. Select the v4.0 for the .NET Framework
version. Click OK. You will be returned to the IIS screen. Your new application pool is listed.
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Figure 49 Creating a New Application Pool

Step 2: Update Settings

1. Right click the Insbridge Application Pool you created and select Advanced Settings.

Advanced Settings H

3 -
i MET Framevaork, Version vd.0
Enable 32-Bit Applications False
Managed Pipeline Made Inkeqrated
Marne IMSBERIDGE
Cueue Length 1000
Skart Automatically True
E CPu
Lirnit 1]
Limit Action Modckion
Limit Inkerval (minutes) 5
Processar Affinity Enabled False —
Pracessar AFFinity Mask, 4294957295
B Process Model
Identity Insbridge
Idle Time-out {minutes) 0
Load User Profile False
Plaxirurm Worker Processes 1
Firng Enabled True
Ping Maximum Response Time (seconc 90
Ping Period (seconds) 30
Shutdown Time Limit (seconds) an
Skartun Time Limik fosrnndst ar hd
Mame
[mame] The application pool name is the unique identifier For the application poal.
Ok, Cancel |
A

Figure 50 Selecting Application Pool Properties
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2. Verify that the .NET Framework Version is v4.0.

3. Verify the identity is Insbridge. If the identity is not Insbridge, you can update it. For the
Identity choose to use custom account and enter the same user that was used to install
Insbridge.

4. Click OK to save your changes.

Step 3: Associate the web applications with the Insbridge Application Pool

Next, you will need verify or associate the Insbridge web applications with the new Insbridge
application pool.

1. Stayin IIS Manager. Under Local Server - Sites - select IBFA, right click and select
Manage Application-> Advanced Settings.

*E Internet Information Services (115} Manager [_ (O]
@ & I P » SERVER ¥ Stes b Defaul wehsSie b IBFA b | &2 @ -
File  “iew Help
£) /IBFA Home E—
- l i l&‘. LEf /I ) Explore
3 Start Page 5 Edit Permissions,..
E| _gg SERVER Filker: - G0 = e Show All |Gr0up by Area - Eij'
é:p Application Pools ASP.NET - D Basic Settings. ..
B-lal %35 & u . view Virtual Directories
=) Default Web Site = N . q E i P
| aspnet_client {B N E > o =R ab Manage Application A
MET MET Error MET WMET Profile .NET Trust Application  Connection B applicati
insh| & Explore [ompilation Pages Globalization Levels Settings Strings - rOWEE ADERICI T
*
(=t Edit Permissions. .. a (8] Browse ™60 (hktp)
RM v — %ﬂ}) ]1 Advanced Settings. .
(S Add Application... GE =] e
% addvirtusl Directory. .. cag::rgrsd Session State  SMTP E-mail \9. Help
online Help
‘ Manage Application » | [@] Browse
&3 Refresh | Advanced Settings. .. a
Remove = , =) 7|l el
X 3 9 o = B &
(2 Swikch bo Content Yiew thotization  Compression Default Directory Ertor Pages Failled Request  Handler
Rules Document Browsing Tracing Rules Mappings
=3 . W E=| =L .:"[I e =
de : 4 IS = ;L.;g =
B ST T &=
HTTP Redirect HTTP IP Address Logging MIME Types Modules Dutput Request
Respa... and Do, Caching Filtering
551 Settings -
Management
— aa =
E:l\ Features View |. - Content Yiew
Ready @i:g

Figure 51 Associating the Virtual Directories with the Insbridge Application Pool

2. Under the General Settings - Application Pool, click the Application Pool entry field to see
the ellipsis (...) button.
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Application Pool DefaultappPool
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Figure 52 Adding Application to Application Pool

Click the ellipsis button. A separate window is displayed.

Select the Insbridge Application Pool.

Click OK. Click OK again to close the Advanced Settings window.

Repeat for RM, and Insbridge.

Return to the Insbridge application pool. Right click and select to view the applications.
Right click to View Applications. The three Insbridge applications should be listed.
Select the server level above the application pools and restart 1IS. On the IS screen,
Actions—>Restart IIS.
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Figure 53 Restarting 1I1S

Application Pool Error
If you choose not to create an Insbridge Application Pool, the Insbridge application will use the

default application pool. If you receive an error when accessing IBFA for the first time after a new
install:

CS0016: Could not write to output file
‘c:\Windows\Microsoft. NET\Framework64\v2.0.50727\Temporary ~ ASP.NET
Files\ibfa\783d6267\bccaOb3e\App_global.asax.zf-kqiii.dll': 'Access is denied. '

You may have to create a separate Insbridge Application Pool.
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TROUBLESHOOTING

In the event that RateManager or IBFA fails to launch, please check the application pool and Com +.

VERIFYING THE INSBRIDGE APPLICATION POOL
Insbridge requires .NET framework setting of v4.5.2. This may present conflicts with other applications in
the default application pool that require a different setting. To avoid conflict and improve performance, a
separate Insbridge Application Pool must be used.

A default Insbridge Application Pool is created at installation. This pool ORACLE_FSGBU_INSBRIDGE

should be used for the Oracle applications. Please verify that the Insbridge web applications are
associated with the new Insbridge application pool.

1. Click Start > Administrative Tools - select IIS Manager.

2. Expandthe Local Computer and select Application Pools. Verify the
ORACLE_FSGBU_INSBRIDGE application pool, the Identity is Insbridge and that there are 3
applications associated. If the pool is correct, proceed to the next step.

= Internet Information Services (1IS) Manager EEIEN)
@C [ 2 » Win1100000 » Application Pools |@ -~ 3 @-
File  View Help
: @3 Application Pool -
ﬁ'}" *_ & J pp (LR ‘: Add Application Pool...
::El Start Page This page lets you view and manage the list of application pools on the server. Application M
4-%g "’}””1100000 pools are asseciated with worker processes, contain one or mere applications, and provide @ Help
--[2} Application Pools isolation ameng different applications.
b-l& Sites
Filter: - Go \gzx) Show All | Group by: _
Name * Status NET CLR V... Managed Pipel... |dentity Ap
L} NET+2.0 Started  v2.0 Integrated ApplicationPoolld.. 0
L5} NETv2.0 Classic  Started  +v2.0 Classic ApplicationPoolld.. 0
[} NET w45 Started w40 Integrated ApplicationPoolld.. 0
L} NET w45 Classic  Started w40 Classic ApplicationPoolld.. 0
) Classic [NET Ap... Started  v2.0 Classic ApplicationPoolld.. 0
L} DefaultAppPool  Started w40 Integrated ApplicationPoolld.. 1
L} 0IDCAppPocl Started 4.0 Integrated ApplicationPoolld.., 1
I {4/ ORACLE FSGBU.. Stated w0 Integrated Insbridge 3
< m >
< m > Features View Content View
Ready Gil
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If the ORACLE_FSGBU_INSBRIDGE has not been created, you will have to create one. Please see
Appendix A, Creating an Application Pool.

Any previous Insbridge application should not be used.

VERIFYING THE COMPONENT SERVICES
Next, you should verify the component services.

Click Start->Server Manager->Tools>Component Services.

Expand the Component Services option under console Root.

Expand Computers>My Computer->COM+ Applications.

Expand each Insbridge COM+ library to make sure there are components listed underneath
each compartment.

. Component Services I;li-
#. File Action View Window Help
os nE XELQ BE D[Rz

[Z Console Root - < < Actions
4 2. Component Services =1 = |
4 || Computers Components  Legacy Roles
4 15 My Computer Components Muore Actions 4
4 | COM+ Applications
COM+ Explorer
COM+ QC Dead Letter Queue Listener
COM+ Utilities
Lo Litilities (32 bt
Insbridge Com+ Administrator 4.5
Insbridge Com+ SoftRater Engine
Insbridge Com+ SoftRater Library
@@ System Application
DCOM Config
_| Running Processes
" | Distributed Transaction Coordinator
I E Event Viewer (Local)
I o Services (Local)

e

Insbridge Com+ Administrat.. =

= IR P

=¥ v T F v % ¥ |

- v v
[

Figure 54 Component Services
There should be 3 Insbridge Com+ Applications libraries:
e Insbridge Com+ Administrator 4.5

¢ Insbridge Com+ SoftRater Engine
e Insbridge Com+ SoftRater Library

NOTE: If any COM+ library is missing, run the Insbridge install again from the msi file and choose
uninstall. Then rerun the IBFA install. Uncheck the RateManager Install. Then check again to see
if all the libraries are listed. If they are still not listed, please log a Service Request with Support.

Verify the Identity of the Com+ Applications Libraries

Please note that you should not have to make any changes to any COM+ Application library. The
installation will automatically apply the Insbridge user name and password that you created earlier to the
necessary libraries.

Upgrade Guide 83



Select the Insbridge Com+ Administrator 4.5.
Right click and select Properties.
Select the Identity tab.

e

change to the Insbridge user set up earlier.

Advanced I Dump | Pooling & Recycling

General I Security | dentity | Activation I Queuing

This application will run under the following account.
Account
() System Account:

() Interactive user - The cument logged on user
() Local Service - Builtdn service account.
() Metwork Service - Builtin service account with network access

) Local Sﬁstem - Complete access to local machine

‘ Insbridge

Passward: ‘iiililll.llll-l |

Confirm password: ‘--------------- |

@ Server applications cannot run under system service accounts.

Leam more about setting these properties.

Figure 55 Updating Com Plus to the Insbridge User

5. Repeat for the other com+ services.
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CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Enterprise Rating System product,
please log a Service Request using My Oracle Support at https://support.oracle.com/.

Oracle customers have access to electronic support through My Oracle Support. For information,
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Address any additional inquiries

to: Oracle Corporation
World

Headquarters

500 Oracle

Parkway

Redwood Shores, CA
94065 U.S.A.

Worldwide

Inquiries: Phone:
+1.650.506.7000

Fax: +1.650.506.7200

oracle.com

Upgrade Guide

85


https://support.oracle.com/
http://www.oracle.com/pls/topic/lookup?ctx=acc&amp;id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&amp;id=trs
http://www.oracle.com/pls/topic/lookup?ctx=acc&amp;id=trs

